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Installing and Configuring Gary Strawn’s Software  
in I-Share Libraries 

 
(Revised July 6, 2011) 

Overview 
 
This document is intended as a supplement for I-Share libraries with the specifics necessary to install and 
configure the five different programs authored by Gary Strawn (Northwestern University) that are 
supported by the CARLI Office for use in I-Share libraries.  These five programs are: 
 
Cataloger’s Toolkit for Voyager (CTKV) 
Correction Review 
Correction Receiver 
Spine Label Printing 
Location Changer 
 
The screen shots and descriptions in this document should be accurate as of 7/6/2011 for each of Mr. 
Strawn’s programs.  As the software is modified, these instructions may require revision as well.   
 
This document is not intended to be a “user’s guide” to Mr. Strawn’s software, but should provide the 
information needed by I-Share libraries to properly install and configure the programs above.  There is a 
separate section in this document for each of the programs.  Libraries should install only those programs 
they intend to use locally; none of them are required by the CARLI Office. 
 
Staff that are responsible for installing the program(s) in the library must read and follow these 
instructions carefully.  If you are not familiar with downloading files, extracting ZIP files, or creating new 
folders on the workstation, please consult with local staff responsible for PC support for assistance with 
these tasks. 
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NOTE: the Correction Review and Correction Receiver programs should only be installed on the 
workstation of the library staff member(s) who will be reviewing and approving batch heading changes in 
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the local database.  The CARLI Office recommends that only a single staff member have access to these 
two programs at the beginning of a library’s implementation of the Strawn utilities. 
 
IMPORTANT NOTE:  Any errors made to bibliographic, holdings, or authority records using any of Mr. 
Strawn’s programs are the responsibility of the library to correct locally.  The CARLI Office will NOT 
restore any database because of errors made to records by imprudent or incorrect use of Mr. Strawn’s 
utilities.  By installing and running any of Mr. Strawn’s programs, the library accepts this policy. 
 

File Locations and Documentation 
 
All of the Strawn programs supported by the CARLI Office are available for download from the CARLI 
website at the URL below. Downloading the programs from the CARLI website assures that the I-Share 
library uses the correct versions of the Strawn software for our environment, as well as the 
programs/versions being supported by the CARLI Office. 
 
http://www.carli.illinois.edu/products-services/i-share/execute  
 
This is the same page used for downloading the Voyager clients.  If staff are accessing this page from 
within an I-Share library, no login/password should be required if the workstation’s IP address is properly 
registered for Reverse DNS lookup.  If staff are accessing this page from off-campus, they will be asked 
to input their institutional affiliation and personal library barcode number.  This number is then validated 
against the library’s patron file.  If there are any problems accessing this page, contact the CARLI Office. 
 
Mr. Strawn’s documentation is available from the URLs below: 
 

• Cataloger’s Toolkit: The cataloger’s toolkit for Vger (online documentation) 
http://files.library.northwestern.edu/ctkv/   

 
• Correction Review and Correction Receiver:  Making Changes to Headings  

http://www.carli.illinois.edu/sites/files/i-
share/documentation/secure/MakingChangesToHeadings.pdf 

 
• Spine Label Printing: Getting Started With the Spine Label Print Program  

http://www.carli.illinois.edu/sites/files/i-share/documentation/secure/vgerspin.pdf  
 

• Location Changer: The Vger location change program 
http://www.carli.illinois.edu/sites/files/i-share/documentation/secure/VgerLocChange.pdf  
 

 
NOTE:  All of these programs require that an ODBC connection to the I-Share reports server be 
established on the workstation prior to configuration of the programs. This is the same ODBC connection 
that is needed when a workstation is used to run the prepackaged or customized Access reports against the 
Voyager database.  As of February 27, 2008, staff must use an Oracle 10g ODBC connection. 
 
In addition, the individual staff member running these Strawn programs must also have an Oracle account 
for this ODBC connection.  If the staff member already has an Oracle account for running Access reports, 
that account can be used for the Strawn programs. If the staff member does not have an Oracle account 
already, the library’s Director, I-Share Liaison, or Security Contact must file a WRO to get this account 
established. 



CARLI Office revised July 6, 2011 Page 3 

 
I-Share-specific instructions for manually installing the Oracle 10g client and ODBC driver connections 
are available from the URL below, and will not be repeated in this document, other than as a reference 
within each appropriate section below.  
 

• CARLI I-Share Oracle 10g/ODBC New Installation Guide 
 

http://www.carli.illinois.edu/sites/files/i-share/documentation/secure/newinstall_10g.pdf  
 

Oracle 10g and the ODBC driver MUST be installed and functional before any installation of any of Mr. 
Strawn’s programs can take place. 
 

(1) First Time Installation of Cataloger’s Toolkit for Voyager (CTKV) on an I-Share 
Library PC 
 
(Preliminary Task) Step 1.0A:  Install and configure ODBC on the workstation 
 
Before you can configure Cataloger’s Toolkit for Voyager (CTKV), the workstation(s) on which CTKV 
is to be used must already be set up with an Oracle/ODBC connection to the I-Share reports server.  See 
the I-Share-specific ODBC installation information available from http://www.carli.illinois.edu/products-
services/i-share/execute and be sure that all tasks as described in Sections I-V (up to the “Link the .MDB 
File”) have been completed for the reports server (eisreport) on each applicable workstation before you 
attempt to install and configure CTKV. 
 
(Preliminary Task) Step 1.0B:  Test the ODBC connection on the workstation 
 
Before installing and configuring CTKV, it is important to verify that the Oracle/OBDC connection to the 
reports server is working correctly.  The instructions in the remainder of this document assume a working 
ODBC connection is already in place on the PC.  If there are any problems encountered in the 
installation/configuration of Mr. Strawn’s programs, it will be much easier to troubleshoot them if it is 
known that the problem is not in the underlying ODBC connection. 
 
There are three ways to confirm a successful Oracle/ODBC connection in the I-Share environment: 
 

(1) If the PC can successfully run Voyager Access reports, then the ODBC connection was set up 
correctly. 

(2) If the Oracle 10g client was installed using the manual installation as detailed in the 
CARLI I-Share Oracle 10g/ODBC New Installation Guide, 
http://www.carli.illinois.edu/sites/files/i-share/documentation/secure/newinstall_10g.pdf, 
and all steps were completed successfully, including section V. “Oracle/ODBC 
Configuration”, then the ODBC connection was set up correctly. 

(3) If the Oracle 10g client was upgraded from a working 9i client as detailed in the 
Migrating from Oracle 9i to Oracle 10g Clients: Oracle/ODBC Installation Guide, then 
the ODBC connection was set up correctly. 
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If you are not certain about the Oracle 10g/ODBC connection for any PC to which the Strawn 
utilities are to be installed, then the ODBC connection tests described in Appendix A of this 
document should be done before proceeding with the installation and configuration of any of Mr. 
Strawn’s programs. 
 
(Preliminary Task) Step 1.0C: Delete any non-current versions of Voyager clients on the 
workstation 
 
CTKV is sensitive to the presence of any future versions of Voyager clients other than the current, 
production version.  In I-Share libraries, the current version is Voyager 7.2.5.  If the workstation has a 
later version of Voyager clients, the installation may go smoothly, but when you attempt to run CTKV for 
the first time, an error message similar to the one below may appear: 
 
“Run time error ‘430’:  Class does not support Automation or does not support expected interface.” 
 
Having previous versions of Voyager (e.g., 7.1) on the PC does not appear to interfere with the 
functionality of CTKV, but tests have shown that the presence of later versions of Voyager on the PC can 
result in the error message above.  Since an earlier version of a Voyager client cannot be used with a 
database at the current version, the usefulness of earlier versions of Voyager on the PC is questionable. 
 
Therefore, to prevent version problems, it is recommended that only the current version of Voyager 
clients should be installed on the workstation.  See section 6.4 of this document for more information on 
removing non-current versions of Voyager clients from the PC.   
 
 
(Preliminary Task) Step 1.0D: Verify proper version of CTKV to install 
 
If the PC to which CTKV is being installed for the first time already has a version of Mr. Strawn’s  
Correction Receiver and/or Location Changer utilities installed, all three of these programs must 
be upgraded to the current version of each program, at the same time.  These three programs 
share DLL files, so upgrading one program without upgrading the others will likely “break” the 
program(s) that are not also upgraded at the same time.  
 
One of the tasks CARLI staff do when testing new versions of Mr. Strawn's programs before 
posting them to the CARLI website (for official support) is to verify this compatibility between 
the different program versions.  The most current version of the Strawn programs supported by 
the CARLI Office (and tested for interoperability) are posted to the CARLI website at the URL 
below: 
 
http://www.carli.illinois.edu/products-services/i-share/execute  
 
The Strawn utilities include the program version number in each program’s Options/About tab.  If 
there is any doubt about the correct version of CTKV to install (if Correction Receiver and/or 
Location Changer are already installed on the PC), the best way to proceed is to re-install the non-
CTKV programs already present with the versions of those programs posted to the CARLI 
website at the same time that CTKV is initially installed.    
 
 



CARLI Office revised July 6, 2011 Page 5 

Step 1.1: Download ZIP files from the CARLI website 
 
The CARLI Office recommends that CTKV be downloaded to a separate folder on the workstation, and 
that the unzipped files be retained on the workstation in case the process requires a re-install.  Unless the 
library uses another convention, a suggestion is to create a folder on the main drive (C:\ on many 
workstations) called “strawn” into which each of the five programs (as applicable) is saved in a separate 
subfolder.  This document uses this convention for illustrative purposes. 
 
In the screen shot below, the main folder for all of the Strawn programs is called C:\strawn, and a separate 
subfolder called CTKV has been created (along with subfolders for the other Strawn programs). 
 

 
 
 
NOTE: the Correction Review and Correction Receiver programs should only be installed on the 
workstation of the library staff member(s) who will be reviewing and approving batch heading changes in 
the local database.  The CARLI Office recommends that only a single staff member have access to these 
two programs at the beginning of a library’s implementation of the Strawn utilities. 
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(1.1A) Using a web browser, go to <http://www.carli.illinois.edu/products-services/i-share/execute> and 
scroll to the section called “Strawn Programs and Documentation.”  (NOTE: the update date and program 
version information on the CARLI website may vary from the screen shot below.) 
 

 
 
 
(1.1B) Click the link called 2007.25.428.CatalogersToolkit.ZIP and follow your browser’s prompts for 
selecting a location on the workstation to which the ZIP file will be saved. 
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When downloading the ZIP file, select the target folder (C:\strawn\CTKV in this example) and 
click Save. 
 

 
 
 
Successful download: 
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If you open the C:\strawn\CTKV folder, the newly downloaded ZIP file is seen: 
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(1.1C) Go back to the CARLI website, and download the file called “CtkSupport.ZIP” to the same folder 
as was used in step 1.1B. 
 
Select the location for downloading the CtkSupport.ZIP file (C:\strawn\CTKV in this example): 
 

 
 
 
Successful download: 
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Step 1.2: UnZip the CTKV files 
 
In the illustrations that follow, Windows XP’s internal functionality is being used to decompress the 
downloaded ZIP files.  Your library may use a different ZIP/decompression utility, as meets local 
requirements.  Of course, the specific instructions and screen shots in this section are not applicable to 
other decompression programs. 
 
(1.2A) Open the folder to which you downloaded the 2007.25.428.CatalogersToolkit.ZIP file.  Double 
click or right click on the ZIP file, then choose Extract All and follow the Wizard prompts.  These 
illustrations will use the Right click option.   
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(1.2B) Click Next at the Extraction Wizard welcome screen.  
 
On the next screen, you will extract the files into the same folder used for the download.  
Therefore, edit the default entry in the input box to be:  C:\strawn\CTKV\ (if you are using the 
same placement of files as illustrated in this document).  Click Next to continue. 
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After the extraction is completed, the option to “Show extracted files” is presented.  Click Finish to 
continue. 
 

 
 
 



CARLI Office revised July 6, 2011 Page 13 

(1.2C) If the “Show extracted files” option is selected, the files below display (note: the icons, dates 
modified, and file sizes may vary from the screen shot below): 
 

 
 
 
Step 1.3: Install CTKV on the workstation 
 
(1.3A) Close/exit any other programs currently running on the workstation. 
 
(1.3B) Open the folder on the PC to which the ZIP files were extracted (C:\strawn\CTKV by default). 
 
(1.3C) Double-click the icon called “setup.exe” to run the program and follow the screen prompts.   
 
If, during setup, you receive a security warning about an unverified publisher, if you downloaded the ZIP 
file from the CARLI website, it is OK to select Run or Continue with the installation process. 
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Click OK to continue if no other programs are currently running on the workstation. 
 
Unless your library has specific policies regarding program file placement, it is recommended that you 
accept the defaults as supplied in the setup program. 
 
Let setup install to the default folder, and click the computer icon to continue: 
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You may accept the default program group name or assign a new name that is more meaningful to the 
local library (e.g., Strawn Utilities). In this document, the default program group name is being used for 
the sake of clarity, but this can be changed as desired locally. 
 

 
 
 
If, during setup, you receive a message similar to the one below, see section 6 (“Installation/Configuration 
Problems and Workarounds”) and follow the steps described in order to complete the installation 
procedure. 
 

 
 
 
If, during setup, you receive an error message referencing a Version Conflict, see section 6 
(“Installation/Configuration Problems and Workarounds”) and follow the steps described in order to 
complete the installation procedure. 
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The successful installation message: 
 

 
 
 
Click OK to close the setup program. 
 
 
Step 1.4:  Move CTKV INI files 
 
(1.4A) For a first time installation on the PC, unzip the “CtkSupport.ZIP” file in the C:\strawn\CTKV 
folder.  This is essentially the same process as described in Step 1.2, but with a different ZIP file and a 
different target folder for the extract.  
 
Right click the CtkSupport.ZIP file and select Extract All: 
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NOTE:  For CtkSupport.ZIP, the files must be extracted to a different target folder from that used when 
CTKV was unzipped.  Click Next at the Extraction Wizard welcome screen.   
 
On the next screen, click the Browse button.  In the Select a destination dialog box, navigate to the folder 
where the Cataloger’s Toolkit was installed (step 1.3C, to C:\Program Files\ctk folder by default), and 
click OK.  
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From the Extraction wizard screen, with the extraction directed to the Program Files\ctk folder, click Next 
to continue.  
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After the extraction is completed, if the option to “Show extracted files” is selected, the C:\Program 
Files\ctk folder (by default) contains these files (note: the icons, dates modified, and file sizes may vary 
from the screen shot below): 
 

 
 
 
(1.4B) Open the folder that contains the Cataloger’s Toolkit program (C:\Program Files\ctk by default) 
and move (i.e., not copy/cut, but use drag and drop) all of the files that end in .INI (not case sensitive) to 
the standard folder on the PC for initialization files.  This target folder’s name varies, depending on the 
version of Windows on the PC.  In Windows 2000, it’s the C:\WINNT folder; in Windows XP, it’s the 
C:\WINDOWS folder. 
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Specifically, the files to be moved are: 
 
CTKV.INI 
VALIDIT.INI 
VERIFIT.INI 
VGERREAD.INI 
 

 
 
 
NOTE:  if your workstation is not set up to display file name extensions, the .INI data may not display.  
The four files to be moved are of the Type “Configuration Settings.” 
 
If the files display without the .INI extension and if you are unsure about moving the correct files, it 
might be helpful to adjust the following Windows display option. With the C:\Program Files\ctk (by 
default) folder open, select Tools -> Folder Options -> View tab.  Then de-select the option under Files 
and Folders to “Hide file extensions for known file types.”  Click OK to activate the change. 
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Once the files are moved, the target folder will contain the four new configuration files (among many 
other files): 
 

 
 
 
This step should only be necessary for a first time installation of Cataloger’s Toolkit on a particular 
workstation, as these files do not usually change from one version of Cataloger’s Toolkit to the next. 
 
 
(1.4C) Optional step:  make a backup copy of the unedited CTKV.INI file and store it in the same folder 
as the CtkSupport.zip files (C:\strawn\CTKV by default).  A suggested naming convention is 
CTKV_BACKUP.INI . 
 
If there are major problems configuring the Cataloger’s Toolkit program, replacing the “broken” version 
of this INI file with a default/unedited copy may prevent the need to completely re-install the program.  
See section 6.6 for more information about possible errors in the CTKV.INI file. 
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(1.4D) Optional: make a shortcut to the ctk.exe file and drag the shortcut to the desktop for an easy way to 
start the Cataloger’s Toolkit program: 
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Step 1.5: Configure CTKV 
 
(1.5A) Open Cataloger’s Toolkit by using the shortcut or go to Start/Programs/Northwestern University 
Library/Cataloger’s Toolkit (by default, if the program group name was not changed during setup). 
 
Click the Options button, which by default is on the top row, seventh button from the left. 
 
 

 
 
This screen displays by default: 
 

 
 
 
NOTE:  When configuring CTKV, staff can click on the question mark icon in the lower left corner of the 
screen to view online, context-sensitive help for the options on each tab.  Clicking this icon will connect 
the staff member to the appropriate section of Mr. Strawn’s online CTKV documentation available from 
http://www.library.northwestern.edu/ctkv/ .
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We will come back to the Button Defaults screen later.  For now, click the Connections tab 
 
(1.5B) Options / Connections tab 
 
This screen displays by default: 
 

 
 
 
Path to Voyager.INI field:  This tells Cataloger’s Toolkit where to find the voyager.ini file on the PC.  
By default, enter C:\Voyager\ .  Be sure to include the final backslash in this field.  Be sure the 
voyager.ini file on the PC is currently configured to point to your production database 
(Server=voyager.carli.illinois.edu) rather than the training server. 
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Click Add to create a new connection. The screen refreshes with the following defaults: 
 

 
 
 
Name field: can be anything you wish.  A suggestion is your I-Share XXX code followed by the word 
“eisreport” as a reminder that the “read” connection is from the I-Share reports server. (See example on 
next page.) 
 
DSN field: enter the Data Source Name from the Oracle/ODBC installation instructions (“eisreport” by 
default, without the quotes and case sensitive). 
 
Type field: this field is intentionally grayed out; leave as V (Voyager)  
 
Character set field: this field is intentionally grayed out; leave as V (Voyager) 
 
Table prefix field:  enter your library’s I-Share three-letter code (upper case), followed by “db.” (without 
the quotes, in lower case, and include the period at the end). (See example on next page.) 
 
Resource files field: leave blank 
 
Read UID field:  the staff member’s Oracle account for accessing the I-Share reports server.  This is not 
the same as the Voyager operator ID. 
 
Read PWD field:  the password associated with the Read UID account.  This is not the same as the 
Voyager operator ID password. 
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Write UID field:  the staff member’s Voyager operator ID that has privileges to add and modify (at least) 
bibliographic and holdings records. 
 
Write PWD field:  the password associated with the Write UID account. 
 
Oracle schema field: leave blank 
 
Then click the OK button just below the Cancel button to the right of the “Resource files” box to save the 
new Connection configuration information. 
 
Example for EIUdb: 
 

 
 
 
Be sure to click the OK button next to the Resource files box when all required entries on this screen are 
complete.   
 
If you get an error message similar to the one below, click OK to close the error window.   
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Highlight the newly created connection (“EIU eisreport” in this example) and click the Change button.  
Verify that the data in the Table prefix field was entered as described above, or change any typographical 
errors in this field.  Click the OK button next to the Resource files box. 
 
If no additional error messages are displayed, click the OK button near the bottom right of the screen to 
save the newly created Connection options. 
 

 
 
 
The message below will display: 
 

 
 
 
Click OK to continue.  Cataloger’s Toolkit will close automatically. 
 
Re-open Cataloger’s Toolkit by using the shortcut or go to Start/Programs/Northwestern University 
Library/Cataloger’s Toolkit (by default, if the program group name was not changed during setup). 
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Click the Options button. 
 
 

 
 
 
Click the General tab to continue configuring Cataloger’s Toolkit. 
 
 
(1.5C) Options / General tab 
 
Some information should be filled in automatically, based on data entry saved in the Connections tab 
during step 1.5B.  Example for EIUdb: 
 

 
 
 
Your initials field:  Enter your initials here. 
 
Vger owning library field:  This field should be filled in with the correct information from your Voyager 
connection.  However, if this field is blank or incorrect, enter the owning library NAME in this field. See 
SysAdmin/System/Owning Libraries for your library’s options. Most I-Share libraries have only one 
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owning library, but if your library has more than one, enter the owning library name for which your 
Voyager operator ID has edit privileges. 
 
Vger cataloging happening location field:  This field should be filled in with the correct information 
from your Voyager connection.  However, if this field is blank or incorrect, enter the appropriate 
happening location NAME (not code) for your Voyager operator ID.  See SysAdmin/Cataloging/Policy 
Definitions/<select policy, and click Edit>/Locations tab.  Any locations that display in the Selected 
locations box on the right that have the “(c)” notation after them are valid Cataloging happening locations 
for your library. 
 
Delay to use when trying to open a record in the cataloging client field:  Leave this set to the default 
value of 50. 
 
The other fields on this tab are set at the discretion of the user/library.  See Gary Strawn’s Cataloger’s 
Toolkit documentation <http://www.library.northwestern.edu/ctkv/> or click the question mark icon in 
the lower left corner of this screen for more information on these options. 
 
Folder for reports and other output files:  This field was introduced with the CTKV version for 
Voyager 7.1.  Libraries may define any folder on the PC that they wish to use for CTKV output reports.  
If the PC will also have other Strawn utilities installed, it is recommended that the same folder be used for 
all reports, and this document uses this convention.   
 
Example for EIUdb: 
 

 
 
 
Click the Button details tab to continue configuring the required options. 
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(1.5D) Options / Button details tab 
 
This screen opens with the following defaults: 
 

 
 
 
There are several buttons on this screen that need to be configured. 
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(1.5D.1) BAM button 
 
Click the first green button on the left side of the screen, labeled BAM. (BAM stands for “Bibliographic 
and Authority verification and MARC validation”) 
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The BAM button configuration opens to this screen by default.  Note that some options may be 
enabled/checked by default differently than in the screen shot below. 
 

 
 
 
For the BAM button, there are a few specific options that must be configured, as described below. 
 
However, many of the options for this button are at the discretion of the user/library’s workflow 
decisions.  The CARLI Office makes no recommendations on these other options at this time. See Gary 
Strawn’s Cataloger’s Toolkit documentation <http://www.library.northwestern.edu/ctkv/> or click the 
question mark icon in the lower left corner of this screen for more information on these options.  
 
Note that some of these options involve the creation of new authority records or editing existing authority 
records.  CARLI staff load the weekly Library of Congress authority files for most I-Share libraries, 
which can replace/overwrite local edits or create duplicates with locally-created authority records.  
Because of this environment, it is assumed that most I-Share libraries will not enable these authority 
record features in Cataloger’s Toolkit. 
 
Click the Files tab to continue with the I-Share-required BAM button configuration options. 
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(1.5D.2) BAM options, Files tab 
 
Path to Vger tag table files field:  tells Cataloger’s Toolkit where on the PC to find the Voyager tag 
tables. By default, enter C:\Voyager\Catalog\TagTable\Oclc\ . Be sure to include the final backslash in 
this field. 
 
Cutter/GACtable field: leave blank (Northwestern University Libraries use only) 
 
Files of validation rules field:  by default, enter C:\Program Files\ctk\ .  Be sure to include the final 
backslash in this field. 
 
Supplementary validation files fields: leave all three fields blank 
 
Example for EIUdb: 
 

 
 
 
Click the Make changes, pt. 1 tab to continue configuring the BAM button. 
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(1.5D.3) BAM Options / Make changes, pt.1 tab 
 
Previously, the CARLI Office recommended that the radio button for “Make no change to record during 
BAM” be selected/enabled.  This recommendation was due to the I-Share environment where a copy of 
the bib record is read from the I-Share reports server rather than from the live, production database.  
However, for libraries/staff that have only the CTKV program installed and are not using Mr. Strawn’s 
Correction Receiver program for processing batch correction requests, the option to “Save changed record 
back to Vger” would allow fuller use of CTKV’s validation tools for correcting individual records.  So, 
this value is one that should be set at the discretion of the local library. 
 

 
 
 
Click the Subject systems tab to continue configuring the BAM button. 
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(1.5D.4) BAM Options / Subject systems tab 
 

 
 
 
The Subject systems of interest field is used during CTKV’s bibliographic record validation.  Upon 
initial installation, this field defaults to LCSH, MeSH and Other.  The numbers next to the brief names in 
this field are the codes used in the second indicator of bibliographic 6XX fields. 
 
Libraries should delete or add entries here to match local cataloging policy/practices.  For example, if 
your library never uses MeSH headings (or more precisely, has no need to perform authority control on 
MeSH headings, even though some may be present in bib records in your database), you should delete the 
entry for MeSH in this section.   
 
Similarly, if your library wishes to perform authority control on LC Annotated Card headings (i.e., 
children’s subject headings), for example, click Add, and then select the AC (1) option from the list of 
options that appear.   
 
If any additions were made on this screen, click the OK button in the Add a subject system of interest box 
to save the changes. 
 
 
After all required and any desired BAM options are configured, click the Return to main options 
display button.  The Button details tab will display by default. 
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(1.5D.5) Batch Correction Request button 
 
Click the fifth yellow button from the left side of the screen, with the big red cross: 
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This screen opens by default: 
 
NOTE: this screen is displayed from the previous screen when any of the three yellow buttons shown 
below are clicked from the main options display screen. 
 

 
 
 
Path for writing correction request field:  this is the folder to which an operator’s batch correction 
requests are sent.  This will be the path/folder used by the Correction Review program to verify and 
approve requests for batch changes, before they are processed.  If the library has a shared network drive 
available, it can be used for this purpose.  Enter the path appropriate to the PC/library’s setup.  Be sure to 
include the final backslash in this field.  (This button can be configured even if the folder entered in this 
field does not exist.  However, the folder will need to be created before CTKV can be used to initiate 
batch correction requests.) 
 
Because of the automatic I-Share loads of weekly LC authority records into most databases, it is assumed 
that the option on this screen related to full stops in authority records will not be selected. 
 
The option to send email notifications for batch corrections can be set at the discretion of the user/library.  
For more details on this option, see Mr. Strawn’s document called Making Changes to Headings, which is 
available from the CARLI website at <http://www.carli.illinois.edu/sites/files/i-
share/documentation/secure/MakingChangesToHeadings.pdf>.  Be sure the version of this document 
consulted was updated as of 4/21/2005 or later, as the email functionality was added to the process after I-
Share’s initial implementation of the Strawn utilities. 
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The other options on this tab are set at the discretion of the user/library.  See Gary Strawn’s Cataloger’s 
Toolkit documentation <http://www.library.northwestern.edu/ctkv/> or click the question mark icon in 
the lower left corner of this screen for more information on these options. 
 
Example for EIUdb: 
 

 
 
 
After the option above is configured, click the Return to main options display button.   
 
The Button details tab will display by default. 
 
Click the Button arrangement tab to proceed with configuring the arrangement of the Cataloger’s 
Toolkit buttons. 
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(1.5E) Button arrangement tab 
 
This screen opens by default: 
 

 
 
 
The settings on this tab are completely at the discretion of the user/library. However, all of the buttons 
whose background color is dark purple represent functionality available to Northwestern University 
Libraries staff only.  To avoid confusion over these buttons in I-Share libraries, the CARLI Office 
recommends that all buttons with a dark purple background be removed from the working version of the 
Cataloger’s Toolkit.  In the default installation, these are all on the bottom row, and are the first three 
buttons from left and the last button on the right. 
 
In addition, the buttons on the bottom row with the S and pound signs represent functionality that the 
CARLI Office is not ready to support at this time.  It is recommended that these buttons also be removed 
from the working version of the Cataloger’s Toolkit. 
 
This button re-arrangement is accomplished by dragging button icons from the Visible buttons side of the 
screen to the Invisible buttons side of the screen. 
 
Mr. Strawn’s Cataloger’s Toolkit documentation includes descriptions of each of these button options 
<http://files.library.northwestern.edu/ctkv/>.  Alternatively, click the question mark icon on the lower left 
side of this screen, which will open the online documentation to the appropriate section. 
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Below is a suggested re-arrangement of the buttons for an I-Share library: 
 

 
 
 
 
(1.5F) Save Options settings 
 
There are no remaining I-Share-required configurations for Cataloger’s Toolkit. 
 
After all desired options are configured, click OK to save the options. 
 
When the Connections options are saved/changed in Cataloger’s Toolkit, the message below may display.  
Click OK to save the required information and quit CTKV. 
 

 
 
 
Restart Cataloger’s Toolkit and verify that all required options were saved as configured. 
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(2) First Time Installation of Correction Review on an I-Share Library PC 
 
NOTE: the Correction Review and Correction Receiver programs should only be installed on the 
workstation of the library staff member(s) who will be reviewing and approving batch heading changes in 
the local database.  The CARLI Office recommends that only a single staff member have access to these 
two programs at the beginning of a library’s implementation of the Strawn utilities. 
 
 
(Preliminary Task) Step 2.0A:  Install, configure, and test ODBC on the workstation 
 
Before you can configure Correction Review, the workstation(s) on which this program is to be used must 
already be set up with an Oracle/ODBC connection to the I-Share reports server.  See the I-Share-specific 
ODBC installation information available from <http://www.carli.illinois.edu/products-services/i-
share/execute> and be sure that all tasks as described in Sections I-V (up to the “Link the .MDB File”) 
have been completed for the reports server (eisreport) on each applicable workstation before you attempt 
to install and configure Correction Review. 
 
See Preliminary Step 1.0B of this document for information about testing the ODBC connection prior to 
the installation of Correction Review. 
 
NOTE: this is the same ODBC connection that is used by Cataloger’s Toolkit, so if you have completed 
preliminary steps 1.0A and 1.0B when installing Cataloger’s Toolkit, there is no need to do step 2.0A 
when installing Correction Review on the same workstation. 
 
 
Step 2.1: Download ZIP file from the CARLI/I-Share website 
 
The CARLI Office recommends that Correction Review be downloaded to a separate folder on the 
workstation, and that the unzipped file be retained on the workstation in case the program requires a re-
install.  Unless the library uses another convention, a suggestion is to create a folder on the main drive 
(C:\ on many workstations) called “strawn” into which each of the five programs (as applicable) is saved 
in a separate subfolder.  This document uses this convention for illustrative purposes. 
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In the illustrations that follow, the main folder for all of the Strawn programs is called C:\strawn, and a 
separate subfolder called Correction review has already been created (along with subfolders for the other 
Strawn programs). 
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(2.1A) Using a web browser, go to <http://www.carli.illinois.edu/products-services/i-share/execute> and 
scroll to the section called “Strawn Programs and Documentation.” (NOTE: the update date and program 
version information on the CARLI website may vary from the screen shot below.) 
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(2.1B) Click the link called CorrectionReview.ZIP and follow your browser’s prompts for selecting a 
location on the workstation to which the CorrectionReview.ZIP file will be saved. 
 
When downloading the ZIP file, select the target folder (C:\strawn\Correction review, by default) and 
click Save. 
 

 
 
 
Successful download: 
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If you open the C:\strawn\Correction review folder, the newly downloaded ZIP file is seen: 
 

 
 
 
Step 2.2: UnZip the Correction Review files 
 
In the illustrations that follow, Windows XP’s internal functionality is being used to decompress the 
downloaded ZIP files.  Your library may use a different ZIP/decompression utility, as meets local 
requirements.  Of course, the specific instructions and screen shots in this section are not applicable to 
other decompression programs. 
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(2.2A) Open the folder to which you downloaded the CorrectionReview.ZIP file.  Double click or right 
click on the ZIP file, then choose Extract All and follow the Wizard prompts.  These illustrations will use 
the Right click option (note: the icons, dates modified, and file sizes may vary from the screen shot 
below). 
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(2.2B) Click Next at the Extraction Wizard welcome screen.  
 
On the next screen, extract the files into the same folder used for the download.  Therefore, edit 
the default entry in the input box to be:  C:\strawn\Correction review\ (if you are using the same 
placement of files as illustrated in this document).  Click Next to continue. 
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(2.2C) After the extraction is completed, if the option to “Show extracted files” is selected, the 
C:\strawn\Correction review folder (by default) will display, containing these files (note: the icons, dates 
modified, and file sizes may vary from the screen shot below): 
 

 
 
 
 
Step 2.3: Install Correction Review on the workstation 
 
(2.3A) Close/exit any other programs currently running on the workstation. 
 
(2.3B) Open the folder on the PC to which the ZIP files were extracted. In this example, the folder is 
C:\strawn\Correction review (see previous screen shot). 
 
(2.3C) Double-click the icon called “setup.exe” to run the program and follow the screen prompts.   
 
If, during setup, you receive a security warning about an unverified publisher, if you downloaded the ZIP 
file from the CARLI website, it is OK to select Run or Continue with the installation process. 
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Click OK to continue if no other programs are currently running on the workstation. 
 
Unless your library has specific policies regarding program file placement, it is recommended that you 
accept the defaults as supplied in the setup program. 
 
Let setup install to the default folder, and click the computer icon to continue: 
 

 
 
 
You may accept the default program group name or assign a new name that is more meaningful to the 
local library (e.g., Strawn Utilities).  If a different program group name is assigned, be sure to use the 
same group name as was used when Cataloger’s Toolkit was installed, so that Correction Review will be 
placed under the same program group name used by Cataloger’s Toolkit. 
 
In this document, the default program group name is being used for the sake of clarity, but this can be 
changed as desired locally. 
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If, during setup, you receive a message similar to the one below, see section 6 (“Installation/Configuration 
Problems and Workarounds”) and follow the steps described there in order to complete the installation 
procedure. 
 

 
 
 
If, during setup, you receive an error message referencing a Version Conflict, see section 6 
(“Installation/Configuration Problems and Workarounds”) and follow the steps described in order to 
complete the installation procedure. 
 
The successful installation message: 
 

 
 
Click OK to close the setup program. 
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(2.3D) Optional: make a shortcut to the CorrectionReview.exe file (in C:\Program 
Files\CorrectionReview by default) and drag the shortcut to the desktop for an easy way to start the 
Correction Review program.   
 
Your folder may or may not have any of the files beginning with ST6UNST as seen in the screen shot 
below.   
 

 
 
 
Step 2.4: Configure Correction Review 
 
(2.4A) Open Correction Review by using a shortcut or go to Start/Programs/ Northwestern University 
Library/Correction review (by default). 
 
The default opening screen should be the Options window. 
 
Select the Connection tab if it is not already displaying. 
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(2.4B) Options / Connection tab 
 
This screen displays: 
 

 
 
 
ODBC data source name field:  enter the Data Source Name from the Oracle/ODBC installation 
instructions (“eisreport” by default, without the quotes and case sensitive). 
 
Table prefix field:  enter your library’s I-Share three-letter code (upper case), followed by “db.” (without 
the quotes, in lower case, and include the period at the end).  (See example on next page.) 
 
Read-only signon field:  the staff member’s Oracle account for accessing the I-Share reports server.  This 
is not the same as the Voyager operator ID. 
 
Read-only password field:  the password associated with the Read-only signon account.  This is not the 
same as the Voyager operator ID password. 
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Example for EIUdb: 
 

 
 
 
Click the Files, etc. tab to continue configuring Correction Review. 
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(2.4C) Options / Files, etc. tab 
 
This screen opens by default: 
 

 
 
 
Click the Add button to begin.  The following screen displays. 
 

 
 
 
At the prompt for the pending queue name, enter the complete path to the folder into which batch 
correction requests generated via Cataloger’s Toolkit are to be placed.  This can be on the PC or a shared 
network drive (if available in the library).  Be sure to include the final backslash in this field.  
 
This folder can be named whatever the library desires, but it must be the same folder as configured in 
CTKV step 1.5D.5 (Batch correction requests), in the “Path for writing correction request” field. 
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Click OK to continue.  The following screen displays. 
 

 
 
 
At the prompt for the approved queue name, enter the complete path to the folder into which approved 
batch correction requests are to be placed.  This can be on the PC or a shared network drive (if available 
in the library).  Be sure to include the final backslash in this field. This folder can be named whatever the 
library desires. 
 
The Approved queue will be used by the Correction Receiver program to actually process the batch 
corrections. 
 
Click OK to continue.  The screen refreshes with the queue information entered above.  Continue the 
configuration by completing the field at the bottom of the screen, as follows. 
 
Folder with Vger tag tables files field:  tells Correction Review where on the PC to find the Voyager tag 
tables. By default, enter C:\Voyager\Catalog\TagTable\Oclc\ . Be sure to include the final backslash in 
this field. 
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Example for EIUdb: 
 

 
 
 
After the Connection and Files, etc. tabs are populated, click OK.  At the Correction Review main menu, 
select Exit to close the program. 
 
In testing the version of Correction Review compatible with Voyager version 6.5.3, CARLI staff 
encountered the error described below.  The CARLI Office is working with Mr. Strawn to troubleshoot 
this particular run-time error, but as of the publication date of this document, the source of this error has 
not been identified.  CARLI staff found no problems running the Correction Review program as a result 
of this error, however, so it is assumed to be a harmless inconvenience. 
 
If, during the configuration of Correction Review, you receive a run-time error similar to the one below, 
click OK to close the error message window. See section 6 (“Installation/Configuration Problems and 
Workarounds”) and follow the steps described in order to complete the configuration. 
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(3) First Time Installation of Correction Receiver on an I-Share Library PC 
 
NOTE: the Correction Review and Correction Receiver programs should only be installed on the 
workstation of the library staff member(s) who will be reviewing and approving batch heading changes in 
the local database.  The CARLI Office recommends that only a single staff member have access to these 
two programs at the beginning of a library’s implementation of the Strawn utilities. 
 
 
(Preliminary Task) Step 3.0A: Install, configure, and test ODBC on the workstation 
 
Before you can configure Correction Receiver, the workstation(s) on which this program is to be used 
must already be set up with an Oracle/ODBC connection to the I-Share reports server.  See the I-Share-
specific ODBC installation information available from <http://www.carli.illinois.edu/products-services/i-
share/execute> and be sure that all tasks as described in Sections I-V (up to the “Link the .MDB File”) 
have been completed for the reports server (eisreport) on each applicable workstation before you attempt 
to install and configure Correction Review. 
 
See Preliminary Step 1.0B of this document for information about testing the ODBC connection prior to 
the installation of Correction Receiver. 
 
NOTE: this is the same ODBC connection that is used by Cataloger’s Toolkit and Correction Review, so 
if you have completed preliminary steps 1.0A and 1.0B when installing Cataloger’s Toolkit or 
preliminary step 2.0A for Correction Review, there is no need to do step 3.0A when installing Correction 
Receiver on the same workstation. 
 
 
(Preliminary Task) Step 3.0B: Verify proper version of Correction Receiver to install 
 
If the PC to which Correction Receiver is being installed for the first time already has a version of Mr. 
Strawn’s Cataloger’s Toolkit (CTKV) and/or Location Changer utilities installed, all three of these 
programs must be upgraded to the current version of each program, at the same time.  These three 
programs share DLL files, so upgrading one program without upgrading the others will likely “break” the 
program(s) that are not also upgraded at the same time.  
 
One of the tasks CARLI staff do when testing new versions of Mr. Strawn's programs before 
posting them to the CARLI website (for official support) is to verify this compatibility between 
the different program versions.  The most current version of the Strawn programs supported by 
the CARLI Office (and tested for interoperability) are posted to the CARLI website at the URL 
below: 
 
http://www.carli.illinois.edu/products-services/i-share/execute 
 
The Strawn utilities include the program version number in each program’s Options/About tab.  If 
there is any doubt about the correct version of Correction Receiver to install (if CTKV and/or 
Location Changer are already installed on the PC), the best way to proceed is to re-install the 
other programs already present with the versions of those programs posted to the CARLI website 
at the same time that Correction Receiver is initially installed.    
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Step 3.1: Download ZIP file from the CARLI/I-Share website 
 
The CARLI Office recommends that Correction Receiver be downloaded to a separate folder on the 
workstation, and that the unzipped file be retained on the workstation in case the process requires a re-
install.  Unless the library uses another convention, a suggestion is to create a folder on the main drive 
(C:\ on many workstations) called “strawn” into which each of the five programs (as applicable) is saved 
in a separate subfolder.  This document uses this convention for illustrative purposes. 
 
In the illustrations that follow, the main folder for all of the Strawn programs is called C:\strawn, and a 
separate subfolder called Correction receiver has already been created (along with subfolders for the other 
Strawn programs). 
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(3.1A) Using a web browser, go to <http://www.carli.illinois.edu/products-services/i-share/execute> and 
scroll to the section called “Strawn Programs and Documentation.”  (NOTE: the update date and program 
version information on the CARLI website may vary from the screen shot below.) 
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(3.1B) Click the link called 2007.25.428.CorrectionReceiver.ZIP and follow your browser’s prompts for 
selecting a location on the workstation to which the ZIP file will be saved. 
 
When downloading the ZIP file, select the target folder (C:\strawn\Correction receiver, by default) and 
click Save. 
 

 
 
Successful download: 
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If you open the C:\strawn\Correction receiver folder, the newly downloaded ZIP file is seen (note: icon 
and file size may vary from the screen shot below): 
 

 
 
 
Step 3.2: UnZip the Correction Receiver files 
 
In the illustrations that follow, Windows XP’s internal functionality is being used to decompress the 
downloaded ZIP files.  Your library may use a different ZIP/decompression utility, as meets local 
requirements.  Of course, the specific instructions and screen shots in this section are not applicable to 
other decompression programs. 



CARLI Office revised July 6, 2011 Page 62 

(3.2A) Open the folder to which you downloaded the 2007.25.428.CorrectionReceiver.ZIP file.  Double 
click or right click on the ZIP file, then choose Extract All and follow the Wizard prompts.  These 
illustrations will use the Right click option. 
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(3.2B) Click Next at the Extraction Wizard welcome screen.  
 
On the next screen, extract the files into the same folder used for the download.  Therefore, edit 
the default entry in the input box to be:  C:\strawn\Correction receiver\ (if you are using the same 
placement of files as illustrated in this document).  Click Next to continue. 
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(3.2C) After the extraction is completed, if the option to “Show extracted files” is selected, the 
C:\strawn\Correction receiver folder (by default) will display, containing these files (note: the icons, dates 
modified, and file sizes may vary from the screen shot below): 
 

 
 
 
Step 3.3: Install Correction Receiver on the workstation 
 
(3.3A) Close/exit any other programs currently running on the workstation. 
 
(3.3B) Open the folder on the PC to which the ZIP files were extracted. In this example, the folder is 
C:\strawn\Correction receiver (see previous screen shot). 
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(3.3C) Click the icon called “setup.exe” and follow the screen prompts.   
 
If, during setup, you receive a security warning about an unverified publisher, if you downloaded the ZIP 
file from the CARLI website, it is OK to select Run or Continue with the installation process. 
 

 
 
 
Click OK to continue if no other programs are currently running on the workstation. 
 
Unless your library has specific policies regarding program file placement, it is recommended that you 
accept the defaults as supplied in the setup program. 
Let setup install to the default folder, and click the computer icon to continue: 
 

 
 
 
You may accept the default program group name or assign a new name that is more meaningful to the 
local library (e.g., Strawn Utilities).  If a different program group name is assigned, be sure to use the 
same group name as was used when Cataloger’s Toolkit and Correction Review were installed, so that 
Correction Receiver will be placed under the same program group name used by the other Strawn 
programs. 
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In this document, the default program group name is being used for the sake of clarity, but this can be 
changed as desired locally. 
 

 
 
 
If, during setup, you receive a message similar to the one below, see section 6 (“Installation/Configuration 
Problems and Workarounds”) and follow the steps described there in order to complete the installation 
procedure. 
 

 
 
 
If, during setup, you receive an error message referencing a Version Conflict, see section 6 
(“Installation/Configuration Problems and Workarounds”) and follow the steps described in order to 
complete the installation procedure. 
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The successful installation message: 
 

 
 
Click OK to close the setup program. 
 
 (3.3D) Optional: make a shortcut to the CorrectionReceiver.exe file (in C:\Program 
Files\CorrectionReceiver by default) and drag the shortcut to the desktop for an easy way to start the 
Correction Receiver program: 
 

 
 
 
Step 3.4: Configure Correction Receiver 
 
(3.4A) Open Correction Receiver by using a shortcut or go to Start/Programs/Northwestern University 
Library/Correction receiver (by default). 
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Click Options from the menu bar:  
 

 
 
 
The Approved queue tab should display by default.  We’ll come back to this tab later.  To 
proceed with the configuration, click the ODBC connection tab. 
 
 
(3.4B) Options / ODBC connection tab: 
 
This screen appears by default: 
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ODBC connection name (DSN) field: enter the Data Source Name from the Oracle/ODBC installation 
instructions (“eisreport” by default, without the quotes and case sensitive). 
 
Read-only user ID field:  the staff member’s Oracle account for accessing the I-Share reports server.  
This is not the same as the Voyager operator ID. 
 
Read-only password:  the password associated with the Read-only user ID.  This is not the same as the 
Voyager operator ID password. 
 
Table name prefix field:  enter your library’s I-Share three-letter code (upper case), followed by “db.” 
(without the quotes, in lower case, and include the period at the end).  (See example on next page.) 
 
Example for EIUdb: 
 

 
 
 
Click the Approved queue tab to continue configuring Correction Receiver.  
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(3.4C) Options / Approved queue tab: 
 
This screen appears by default: 
 

 
 
 
Click the Add button to continue.  The following screen displays. 
 

 
 
 
At the prompt for the approved queue name, enter the complete path to the folder to which approved 
batch correction requests are to be found by the Correction Receiver program, for its processing.  This can 
be on the PC or a shared network drive (if available in the library).  Be sure to include the final backslash 
in this field.  
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This folder can be named whatever the library desires, but it must be the same folder as configured in 
Correction Review step 2.4C, in the “Approved queue” field. 
 
Click OK after the path to the queue has been entered. 
 
Number of seconds … field:  This is the delay time that Correction Receiver waits between finishing the 
processing of one request and checking the Approved queue for another request.  The maximum wait time 
is 20 seconds.  The default value is 2 seconds.  This value can be set at the library’s discretion. 
 
 
Example for EIUdb: 
 

 
 
 
Click the Validation tab to continue configuring Correction Receiver.  
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(3.4D) Options / Validation tab: 
 
This screen appears by default: 
 

 
 
 
Validation scheme field:  At this time, the CARLI Office recommends that the third option (No 
validation) be selected. 
 
Path to Vger tag table files field:  tells Correction Receiver where on the PC to find the Voyager tag 
tables. By default, enter C:\Voyager\Catalog\TagTable\Oclc\ .  Be sure to include the final backslash in 
this field. 
 
Path to files of validation rules field:  tells Correction Receiver where on the PC to find the basic set of 
validation rules defined for the validation tool.  Enter the full path to the Cataloger’s Toolkit program 
(C:\Program Files\ctk\ by default).  Be sure to include the final backslash in this field. 
 
Path to compressed tag table field:  by default, leave this field blank. 
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Example for EIUdb: 
 

 
 
 
Click the Output handling tab to continue configuring Correction Receiver.  
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(3.4E) Options / Output handling tab: 
 
This screen appears by default: 
 

 
 
 
For more details on these options, see Mr. Strawn’s document called Making Changes to Headings. This 
document is available from the CARLI website at <http://www.carli.illinois.edu/sites/files/i-
share/documentation/secure/MakingChangesToHeadings.pdf>. 
 
By default for the initial configuration, the radio button “This is a test…” is selected on this screen.  This 
is where the staff member running the program will tell Correction Receiver whether to test the proposed 
change requests (but not to actually perform the changes) or to proceed with editing the bib records in 
question in the local Voyager database. 
 
The CARLI Office STRONGLY recommends that libraries run the “test” option on each correction 
request, and review the log files showing what the request would do to the appropriate bibs, before the 
changes are actually written to the Voyager database.   
 
The setting for “This is a test” or “Write changed records to Vger” does not reset to “This is a test” after 
the initial configuration.  In other words, once this option is set to “Write changed records to Vger,” that 
setting remains in place until it is manually changed to “This is a test” by the user.  Because of this, it is 
important that the person running Correction Receiver check the Output handling tab options every time 
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Correction Receiver is opened for processing, to make sure the intended test run will actually be done as a 
test and not as a production run. 
 
IMPORTANT NOTE:  Any errors made in correcting batches of records using any of Mr. Strawn’s 
programs are the responsibility of the library to correct locally.  The CARLI Office will NOT restore any 
database because of errors made to records by imprudent or incorrect use of Mr. Strawn’s utilities. 
 
There are no start time limitations on test runs, since the test runs do not send any records to the 
production server.  Test runs can be performed during normal business hours.  See below for more 
information on timing limitations for production runs of batch changes. 
 
After the test has been run, reviewed, and approved by appropriate library staff, then the Output handling 
option can be changed to “Write changed records to Vger.”  In the I-Share environment, when this option 
is selected, the Correction Receiver program will not actually begin submitting the changes until the 
appropriate batch job time on the production server (currently, that window is 10 PM to 2 AM, seven 
days a week).  This means the PC must be left on and the Correction Receiver program must be running 
after “normal” business hours.   
 
Note: the staff member running Correction Receiver in production (i.e., non-test) mode must also select 
Start (from the main menu) to initiate the batch changes.  The program will display “Active” and will wait 
until 10 pm to submit the first change request to the production database. 
 
For more information about workflow implications of running Correction Receiver in the I-Share 
environment, see the document entitled “Getting Started Using Gary Strawn’s Software in I-Share 
Libraries” available from <http://www.carli.illinois.edu/sites/files/i-
share/documentation/secure/StartStrawn.pdf>. 
 
Folder for archiving of correction requests field:  If the correction request should be archived for 
possible re-use in the future, the path/folder on the PC to which the requests are to be saved must be 
entered in this field.  Be sure to include the final backslash in this field.  This path/folder can be set at the 
discretion of the user/library.  A path/folder can be entered here before it is created on the PC, but it must 
be found by Correction Receiver at the time a request should be archived for this option to function 
properly. 
 
The logging of results options on this screen are at the discretion of the library.  The CARLI Office 
recommends, at least for the library’s initial implementation of Correction Receiver, that at least the 
following options are checked/enabled: 
 

• Write details of changes to file (this is particularly useful in combination with the test changes 
option) 

• Write summary report 
• Write update errors to file 
• Write each change request to cumulative file 

 
Folder for reports field:  If any log reports are checked on this screen, the path/folder on the PC to 
which the reports are written must be entered in this field.  Be sure to include the final backslash in this 
field.  This path/folder can be set at the discretion of the user/library.  It is recommended that the same 
folder be used for all Strawn utility output reports, and this document uses this convention. 
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Example for EIUdb: 
 

 
 
 
Click OK to continue.  The message below should appear: 
 

 
 
 
After you click OK, the Voyager tab should display by default.  If it does not, manually click the 
Voyager tab to continue configuring Correction Receiver.  
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(3.4F) Options / Voyager tab: 
 
The screen below appears.  The Cataloging location field should be populated with a value taken from 
data entry linked to the ODBC connection information entered in step 3.4B.   
 
If the cataloging location information is not automatically populated at this point, click OK to close the 
options tabs, then exit the program. Restart Correction Receiver by using a shortcut or go to 
Start/Programs/Northwestern University Library/Correction receiver (by default).  Return to the Options/ 
Voyager tab, and the default cataloging location information should be populated automatically. 
 
Example for EIUdb: 
 

 
 
 
Path to Voyager.INI field:  by default, enter C:\Voyager\ .  Be sure to include the final backslash in this 
field. 
 
Voyager user ID field:  the staff member’s Voyager operator ID that has privileges to add and modify (at 
least) bibliographic and holdings records.  Some users of Mr. Strawn’s software create a unique Voyager 
operator ID that is used with the Correction Receiver program only, for statistical purposes.  (This is the 
operator ID that will display in the History tab of any bib records modified by Correction Receiver.)  If 
the library wishes to do this, the Voyager operator ID is created in Voyager’s SysAdmin/Security, and 
must be linked to a Cataloging profile that has privileges to add and modify (at least) bibliographic and 
holdings records.  This decision is at the library’s discretion. 
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Voyager password field:  the password associated with the Voyager User ID account entered above. 
 
Cataloging location field:  This field should be filled in with the correct information from the ODBC 
connection data entry.  However, if this field is blank or incorrect, enter the appropriate cataloging 
happening location NAME (not code) for the Voyager user ID entered above.  See 
SysAdmin/Cataloging/Policy Definitions/<select policy, and click Edit>/Locations tab.  Any locations 
that display in the Selected locations box on the right that have the “(c)” notation after them are valid 
Cataloging happening locations for your library. 
 
Example for EIUdb: 
 

 
 
 
(3.4G) Save configuration options and Exit 
 
After all required and desired tabs are populated, click OK to save the configuration.   
 
After OK is clicked, a window may appear with a message about checking Cataloging locations on the 
Voyager tab.  If this message is received, go to the Voyager tab and verify/correct the Cataloging location 
name entered there. When the Cataloging location is correct, click OK to save and continue. 
 
At the Correction Receiver main menu (the Window title is Perform ‘batch’ corrections), select Exit to 
close the program. 
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(4) First Time Installation of Spine Label Printing on an I-Share Library PC 
 
(Preliminary Task) Step 4.0A:  Install, configure, and test ODBC on the workstation 
 
Spine Label Printing’s automatic copying of call numbers feature requires an ODBC connection for 
“reading” MFHD records.  These installation instructions assume the library wants to use the full 
functionality of this program. Therefore, before you can configure Spine Label Printing, the 
workstation(s) on which this program is to be used must already be set up with an ODBC connection to 
the I-Share reports server.  See the I-Share-specific ODBC installation options available from 
<http://www.carli.illinois.edu/products-services/i-share/execute> and be sure that all tasks as described in 
Sections I-V (up to the “Link the .MDB File”) have been completed for the reports server (eisreport) on 
each applicable workstation before you attempt to install and configure Correction Receiver. 
 
See Preliminary Step 1.0B of this document for information about testing the ODBC connection prior to 
the installation of Spine Label Printing. 
 
NOTE: this is the same ODBC connection that is used by Cataloger’s Toolkit, so if you have completed 
this step when installing Cataloger’s Toolkit, there is no need to do step 4.0A when installing Spine Label 
Printing on the same workstation. 
 
 
(Preliminary Task) Step 4.0B: Delete any non-current versions of Voyager clients on the 
workstation 
 
Spine Label Printing is sensitive to the presence of any future versions of Voyager clients other than the 
current, production version.  In I-Share libraries, the current Voyager version is 7.2.5.  If the workstation 
has a later version of the Voyager clients, the installation may go smoothly, but when you attempt to run 
Spine Label Printing for the first time, an error message similar to the one below may appear: 
 
“Run time error ‘430’:  Class does not support Automation or does not support expected interface.” 
 
Having previous versions of Voyager clients (e.g., 7.1) on the PC does not appear to interfere with the 
functionality of Spine Label Printing, but tests have shown that the presence of later versions of Voyager 
clients on the PC can result in the error message above.  Since an earlier version of a Voyager client 
cannot be used with a database at the current version, the usefulness of earlier versions of Voyager on the 
PC is questionable. 
 
Therefore, to prevent the version problem, it is recommended that only the current version of Voyager 
clients should be installed on the workstation.  See section 6.4 of this document for more information on 
removing non-current versions of Voyager clients from the PC.   
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Step 4.1: Download ZIP file and INI file(s) from the I-Share website 
 
The CARLI Office recommends that Spine Label Printing be downloaded to a separate folder on the 
workstation, and that the unzipped file be retained on the workstation in case the process requires a re-
install.  Unless the library uses another convention, a suggestion is to create a folder on the main drive 
(C:\ on many workstations) called “strawn” into which each of the five programs (as applicable) is saved 
in a separate subfolder.  This document uses this convention for illustrative purposes. 
 
In the illustrations that follow, the main folder for all of the Strawn programs is called C:\strawn, and a 
separate subfolder called Spine label printing has already been created (along with subfolders for the 
other Strawn programs). 
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(4.1A) Using a web browser, go to <http://www.carli.illinois.edu/products-services/i-share/execute> and 
scroll to the section called “Strawn Programs and Documentation.”  (NOTE: the update date and program 
version information on the CARLI website may vary from the screen shot below.) 
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(4.1B) Click the link called SpineLabels.ZIP and follow your browser’s prompts for selecting a location 
on the workstation to which the ZIP file will be saved. 
 
When downloading the ZIP file, select the target folder (C:\strawn\Spine label printing, by default) and 
click Save. 
 

 
 
 
Successful download: 
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If you open the C:\strawn\Spine label printing folder, the newly downloaded ZIP file is seen: 
 

 
 
 
(4.1C) Using a web browser, go back to the CARLI website <http://www.carli.illinois.edu/products-
services/i-share/execute> and scroll to the section called “Strawn Programs and Documentation” (see 
screen shot in step 4.1A, if needed). 
 
Click the file called vgerspin.ini and follow your browser’s prompts for selecting a location on the 
workstation to which the INI file will be saved. 
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When downloading the INI file, select the target folder (C:\strawn\Spine label printing, by default) and 
click Save. 
 

 
 
 
Successful download: 
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If you open the C:\strawn\Spine label printing folder on the PC, both the newly downloaded ZIP file and 
the INI file are seen (note: the icons and file sizes may vary from the screen shot below): 
 

 
 
 
(4.1D) OPTIONAL:  If your library will be using a ZebraTM printer for producing spine labels, then you 
must also download the file called VgerSpinPrinter.INI from the CARLI website.  If your library is not 
using a ZebraTM printer, you should skip this section and proceed to step 4.2. 
 
Using a web browser, go back to the CARLI website <http://www.carli.illinois.edu/products-services/i-
share/execute> and scroll to the section called “Strawn Programs and Documentation” (see screen shot in 
step 4.1A, if needed). 
 
Click the file called VgerSpinPrinter.INI and follow your browser’s prompts for selecting a location on 
the workstation to which the INI file will be saved. 
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When downloading the INI file, select the target folder (C:\strawn\Spine label printing, by 
default) and click Save. 
 

 
 
 
Successful download: 
 

 
 
 



CARLI Office revised July 6, 2011 Page 87 

If you open the C:\strawn\Spine label printing folder on the PC, the newly downloaded ZIP file and both 
of the INI files are seen (note: the icons and file sizes may vary from the screen shot below): 
 

 
 
 
Step 4.2: UnZip the Spine Label Printing files 
 
In the illustrations that follow, Windows XP’s internal functionality is being used to decompress the 
downloaded ZIP files.  Your library may use a different ZIP/decompression utility, as meets local 
requirements.  Of course, the specific instructions and screen shots in this section are not applicable to 
other decompression programs. 
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(4.2A) Open the folder to which you downloaded the SpineLabels.ZIP file.  Double click or right click on 
the ZIP file, then choose Extract All and follow the Wizard prompts.  These illustrations will use the 
Right click option (note: the icons, dates modified, and file sizes may vary from the screen shot below). 
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(4.2B) Click Next at the Extraction Wizard welcome screen.  
 
On the next screen, extract the files into the same folder used for the download.  Therefore, edit 
the default entry in the input box to be:  C:\strawn\Spine label printing\ (if you are using the same 
placement of files as illustrated in this document).  Click Next to continue. 
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(4.2C) After the extraction is completed, if the option to “Show extracted files” is selected, the 
C:\strawn\Spine label printing folder (by default) will display, containing these files (note: the icons, 
dates modified, and file sizes may vary from the screen shot below). 
 
(NOTE: the VgerSpinPrinter.INI file is only present if the library performed optional step 4.1D.) 
 

 
 
 
Step 4.3: Install Spine Label Printing on the workstation 
 
(4.3A) Close/exit any other programs currently running on the workstation. 
 
(4.3B) Open the folder on the PC to which the ZIP files were extracted. In this example, the folder is 
C:\strawn\Spine label printing (see previous screen shot). 
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(4.3C) Double-click the icon called “setup.exe” and follow the screen prompts.   
 
If, during setup, you receive a security warning about an unverified publisher, if you downloaded the ZIP 
file from the CARLI website, it is OK to select Run or Continue with the installation process. 
 

 
 
 
Click OK to continue if no other programs are currently running on the workstation. 
 
Unless your library has specific policies regarding program file placement, it is recommended that you 
accept the defaults as supplied in the setup program. 
 
Let setup install to the default folder, and click the computer icon to continue: 
 

 
 
 
You may accept the default program group name or assign a new name that is more meaningful to the 
local library (e.g., Strawn Utilities).  If a different program group name is assigned, be sure to use the 
same group name as was used when Cataloger’s Toolkit (and other Strawn programs, if applicable) was 
installed, so that Spine Label Printing will be placed under the same program group name used by the 
other Strawn programs. 



CARLI Office revised July 6, 2011 Page 92 

In this document, the default program group name is being used for the sake of clarity, but this can be 
changed as desired locally. 
 

 
 
 
If, during setup, you receive a message similar to the one below, see section 6 (“Installation/Configuration 
Problems and Workarounds”) and follow the steps described there in order to complete the installation 
procedure. 
 

 
 
 
If, during setup, you receive an error message referencing a Version Conflict, see section 6 
(“Installation/Configuration Problems and Workarounds”) and follow the steps described in order to 
complete the installation procedure. 
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The successful installation message: 
 

 
 
 
Click OK to close the setup program. 
 
 
(4.3D) Optional: make a shortcut to the VgerSpin.exe file (in C:\Program Files\VgerSpin\ by default) and 
drag the shortcut to the desktop for an easy way to start the Spine Label Printing program. 
 
Your folder may or may not have any of the files beginning with ST6UNST as seen in the screen shot 
below.   
 

 
 
 
Step 4.4:  Copy and Configure Spine Label Printing INI files 
 
(4.4A) Go to the folder to which you downloaded the Spine Label Printing INI file(s) in Step 4.1C.  If you 
followed the defaults in this document, this folder would be C:\strawn\Spine label printing. 
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Copy the file called “vgerspin.ini” (and also the file “VgerSpinPrinter.INI” if you are using a ZebraTM 
printer) to the standard folder on the PC for initialization files.  This target folder’s name varies, 
depending on the version of Windows on the PC.  In Windows 2000, it’s the C:\WINNT folder; in 
Windows XP, it’s the C:\WINDOWS folder. 
 
(4.4B) Open the newly copied file (in the C:\WINNT or C:\WINDOWS folder) called “vgerspin.ini” 
using Notepad. You may need to change the “Files of type” value to “All files” in order for this file to 
appear in the Open window. 
 
Using Notepad’s Replace functionality, change all occurrences of “XXXDB.” (without the quotes) to 
your library’s I-Share three-letter code (upper case), followed by “db.” (without the quotes, in lower case, 
and be sure to include the period at the end). 
 
Save the edited vgerspin.ini file, being sure to retain the original file name. 
 
 
Step 4.5: Configure Spine Label Printing  
 
(4.5A) Open Spine Label Printing by using a shortcut or go to Start/Programs/ Northwestern University 
Library/Spine labels (by default). 
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The program opens to the screen below by default.  Click the Options button found at the bottom right 
side of the screen. 
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This screen opens with the following defaults: 
 

 
 
 
Click the Files, etc. tab to continue configuring Spine Label Printing.  
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(4.5B) Options / Files, etc. tab 
 
This screen opens with defaults that look something like this: 
 

 
 
 
Data source field:  replace the default entry with the Data Source Name from the I-Share-specific 
Oracle/ODBC installation instructions (“eisreport” by default, without the quotes and case sensitive). 
 
Table prefix field:  If the default value here is XXXDB, enter your library’s I-Share three-letter code 
(upper case), followed by “db.” (without the quotes, in lower case, and include the period at the end).  
(NOTE:  This field may already have the correct code entered, based on the data entry done in step 4.4B.) 
 
User ID field:  replace the default “dbread” with the staff member’s Oracle account for accessing the I-
Share reports server.  This is not the same as the Voyager operator ID. 
 
Password field:  replace the default “dbread” with the password associated with the User ID account 
entered in the field above.  This is not the same as the Voyager operator ID password. 
 
File of old orders field: ignore this field; it is used by Northwestern University Libraries staff only. 
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Output file folder field:  Enter the path to a folder on the PC (or shared Network drive, if applicable) 
where the files of spine labels will be stored before processing.  Be sure to include the final backslash in 
this field.  This path/folder can be named at the discretion of the user/library. 
 
The rest of the fields on this tab are set at the discretion of the user/library.  Refer to Mr. Strawn’s 
documentation for the Spine Label Printing program for more details on these options 
<http://www.carli.illinois.edu/sites/files/i-share/documentation/secure/vgerspin.pdf>. 
 
Example for EIUdb: 
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(4.5C) Options / other tabs 
 
The values on the remaining Options tabs are set at the discretion of the library.  Refer to Mr. Strawn’s 
documentation for the Spine Label Printing program for more details on these options 
<http://www.carli.illinois.edu/sites/files/i-share/documentation/secure/vgerspin.pdf>. 
 
NOTE: on the Options/Components tab, the Location information (if enabled) is taken by default from 
the Voyager database’s SysAdmin/System/Locations/Spine Label Name.  If this value is left blank in 
SysAdmin, no location information prints on spine labels created using this program. 
 
The CARLI Office strongly recommends that the library perform many tests (e.g., with records 
containing different types of call numbers, prefixes, and from different locations) while determining the 
remaining spine label options. It might take a fair amount of Options “tweaking” before the best 
configuration is determined for an individual library. 
 
After all required and desired configuration options are set, click OK to save the settings. 
 
Click the Exit button on the main Spine Label Printing screen (the Window title is “Print spine labels”) to 
close the program. 
 
 

(5) First Time Installation of Location Changer on an I-Share Library PC 
 
(Preliminary Task) Step 5.0A:  Install, configure, and test ODBC on the workstation 
 
Before you can configure Location Changer, the workstation(s) on which the program is to be used must 
already be set up with an Oracle/ODBC connection to the I-Share reports server.  See the I-Share-specific 
ODBC installation information available from <http://www.carli.illinois.edu/products-services/i-
share/execute> and be sure that all tasks as described in Sections I-V (up to the “Link the .MDB File”) 
have been completed for the reports server (eisreport) on each applicable workstation before you attempt 
to install and configure Location Changer. 
 
See Preliminary Step 1.0B of this document for information about testing the ODBC connection prior to 
the installation of Location Changer. 
 
NOTE: this is the same ODBC connection that is used by Cataloger’s Toolkit and the other Strawn 
programs, so if you have completed preliminary steps 1.0A and 1.0B when installing Cataloger’s Toolkit, 
there is no need to do step 5.0A when installing Location Changer on the same workstation. 
 
 
(Preliminary Task) Step 5.0B: Verify proper version of Location Changer to install 
 
If the PC to which Location Changer is being installed for the first time already has a version of Mr. 
Strawn’s Cataloger’s Toolkit (CTKV) and/or Correction Receiver utilities installed, all three of these 
programs must be upgraded to the current version of each program, at the same time.  These three 
programs share DLL files, so upgrading one program without upgrading the others will likely “break” the 
program(s) that are not also upgraded at the same time.  
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One of the tasks CARLI staff do when testing new versions of Mr. Strawn's programs before 
posting them to the CARLI website (for official support) is to verify this compatibility between 
the different program versions.  The most current version of the Strawn programs supported by 
the CARLI Office (and tested for interoperability) are posted to the CARLI website at the URL 
below: 
 
http://www.carli.illinois.edu/products-services/i-share/execute 
 
The Strawn utilities include the program version number in each program’s Options/About tab.  If 
there is any doubt about the correct version of Location Changer to install (if CTKV and/or 
Correction Receiver are already installed on the PC), the best way to proceed is to re-install the 
other programs already present with the versions of those programs posted to the CARLI website 
at the same time that Location Changer is initially installed.    
 
 
Step 5.1: Download ZIP files from the CARLI website 
 
The CARLI Office recommends that Location Changer be downloaded to a separate folder on the 
workstation, and that the unzipped files be retained on the workstation in case the process requires a re-
install.  Unless the library uses another convention, a suggestion is to create a folder on the main drive 
(C:\ on many workstations) called “strawn” into which each of the five programs (as applicable) is saved 
in a separate subfolder.  This document uses this convention for illustrative purposes. 
 
In the screen shot below, the main folder for all of the Strawn programs is called C:\strawn, and a separate 
subfolder called Location Changer has been created (along with subfolders for the other Strawn 
programs). 
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(5.1A) Using a web browser, go to <http://www.carli.illinois.edu/products-services/i-share/execute> and 
scroll to the section called “Strawn Programs and Documentation.”  (NOTE: the update date and program 
version information on the CARLI website may vary from the screen shot below.) 
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(5.1B) Click the link called 2007.25.428.LocationChanger.ZIP and follow your browser’s prompts for 
selecting a location on the workstation to which the ZIP file will be saved. 
 
When downloading the ZIP file, select the target folder (C:\strawn\Location changer in this example) and 
click Save. 
 

 
 
Successful download: 
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If you open the C:\strawn\Location changer folder, the newly downloaded ZIP file is seen: 
 

 
 
 
 
Step 5.2: UnZip the Location Changer files 
 
In the illustrations that follow, Windows XP’s internal functionality is being used to decompress the 
downloaded ZIP files.  Your library may use a different ZIP/decompression utility, as meets local 
requirements.  Of course, the specific instructions and screen shots in this section are not applicable to 
other decompression programs. 
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(5.2A) Open the folder to which you downloaded the 2007.25.428.LocationChanger.ZIP file.  Double 
click or right click on the ZIP file, then choose Extract All and follow the Wizard prompts.  These 
illustrations will use the Right click option. 
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(5.2B) Click Next at the Extraction Wizard welcome screen.  
 
On the next screen, extract the files into the same folder used for the download.  Therefore, edit the 
default entry in the input box to be:  C:\strawn\Location changer\ (if you are using the same placement of 
files as illustrated in this document).  Click Next to continue. 
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(5.2C) After the extraction is completed, if the option to “Show extracted files” is selected, the 
C:\strawn\Location changer folder (by default) will display, containing these files (note: the icons, dates 
modified, and file sizes may vary from the screen shot below): 
 

 
 
 
 
 
Step 5.3: Install Location Changer on the workstation 
 
(5.3A) Close/exit any other programs currently running on the workstation. 
 
(5.3B) Open the folder on the PC to which the ZIP files were extracted (C:\strawn\Location changer by 
default). 
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(5.3C) Double-click the icon called “setup.exe” to run the program and follow the screen prompts.   
 
If, during setup, you receive a security warning about an unverified publisher, if you downloaded the ZIP 
file from the CARLI website, it is OK to select Run or Continue with the installation process. 
 

 
 
 
Click OK to continue if no other programs are currently running on the workstation. 
 
Unless your library has specific policies regarding program file placement, it is recommended that you 
accept the defaults as supplied in the setup program. 
 
Let setup install to the default folder, and click the computer icon to continue: 
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You may accept the default program group name or assign a new name that is more meaningful to the 
local library (e.g., Strawn Utilities). In this document, the default program group name is being used for 
the sake of clarity, but this can be changed as desired locally. 
 

 
 
 
If, during setup, you receive a message similar to the one below, see section 6 (“Installation/Configuration 
Problems and Workarounds”) and follow the steps described in order to complete the installation 
procedure. 
 

 
 
 
If, during setup, you receive an error message referencing a Version Conflict, see section 6 
(“Installation/Configuration Problems and Workarounds”) and follow the steps described in order to 
complete the installation procedure. 
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The successful installation message: 
 

 
 
 
Click OK to close the setup program. 
 
 
(5.3D) Optional: make a shortcut to the LocationChanger.exe file (in C:\Program files\LocationChanger 
by default) and drag the shortcut to the desktop for an easy way to start the Location Changer program. 
 
Your folder may or may not have any of the files beginning with ST6UNST as seen in the screen shot 
below.   
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Step 5.4: Configure Location Changer 
 
(5.4A) Open Location Changer by using the shortcut or go to Start/Programs/Northwestern University 
Library/LocationChanger (by default, if the program group name was not changed during setup). 
 
(5.4B) Options / Connection tab 
 
The screen below should display by default when opening Location Changer for the first time.  If it does 
not, click on the Connection tab. 
 

 
 
 
Data source name field: enter the Data Source Name from the I-Share-specific Oracle/ODBC 
installation instructions (“eisreport” by default, without the quotes and case sensitive). 
 
Database prefix field:  enter your library’s I-Share three-letter code (upper case), followed by “db.” 
(without the quotes, in lower case, and include the period at the end). 
 
Login for reading field:  enter the staff member’s Oracle account for accessing the I-Share reports 
server.  This is not the same as the Voyager operator ID. 
 
Password for reading field:  enter the password associated with the Logon for reading account.  This is 
not the same as the Voyager operator ID password. 
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Logon for writing field:  enter the staff member’s Voyager operator ID that has privileges to add and 
modify (at least) bibliographic, holdings, and item records. 
 
Password for writing field:  enter the password associated with the Logon for writing account. 
 
 
Example for EIUdb: 
 

 
 
 
Next click on the File locations tab. 
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(5.4C) Options / File locations tab 
 
The screen below should display by default.  
 

 
 
 
Path to Vger tag table files field:  tells Location Changer where on the PC to find the Voyager tag 
tables. By default, enter C:\Voyager\Catalog\TagTable\Oclc\ . Be sure to include the final backslash in 
this field. 
 
Path to Voyager.INI field: tells Location Changer where to find the voyager.ini file on the PC.  By 
default, enter C:\Voyager\ .  Be sure to include the final backslash in this field.  Be sure the voyager.ini 
file on the PC is currently configured to point to your production database 
(Server=voyager.carli.illinois.edu) rather than the training server. 
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Example for EIUdb: 
 

 
 
 
Click the OK button when all required entries on this screen are complete, in order to save the newly 
created Connection and File location options.  The message below will display.  Click OK to continue. 
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If you get an error message similar to the one below, click No to close the error window, and as instructed 
ignore (i.e., click No or OK) for any subsequent error messages that may appear while Location Changer 
quits.   
 

 
 
 
If it the program did not close automatically, manually exit the Location Changer program by clicking the 
X in upper right part of the screen.  (The Exit menu bar selection doesn’t seem to work at this point of the 
configuration process.).  Ignore any additional error messages that may be received while Location 
Changer shuts down. 
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(5.4D) Options / General tab 
 
Re-open Location Changer by using the shortcut or go to Start/Programs/Northwestern University 
Library/Location changer (by default, if the program group name was not changed during setup). 
 
Click the Options menu bar selection. 
 

 
 
 
Click the General tab.   
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Some values will be populated by default, based on data entered on the Connections and File locations 
tabs.  Example for EIUdb: 
 

 
 
 
Owning libraries field: Edit this field only if your library has established more than one owning library 
in Voyager System Administration.  I-Share libraries that use more than one owning library are strongly 
encouraged to review Mr. Strawn’s The Vger location change program documentation for considerations 
related to this option. 
 
Cataloging location field:  Select the appropriate cataloging happening location for the Voyager operator 
ID entered on the Connections tab. 
 
Reset “big batches” tab option:  CARLI recommends that for a library’s initial implementation of 
Location Changer, that this option be checked/enabled, to avoid unintentional parameters being set in 
batch change requests. 
 
The other fields on this tab are set at the discretion of the user/library.  Of course, if a library uses item 
barcodes that legitimately contain alphabetic characters, staff from that library would not want to 
check/enable the “Barcodes must be numeric” option.  
 
Staff should review Mr. Strawn’s The Vger location change program documentation for more details 
related to the options on this tab. 
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Example for EIUdb: 
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(5.4E) Options / Sounds tab 
 
Location Changer can be configured to produce different sounds when Record-by-record change requests 
are successful or not.  The settings on this tab are set at the discretion of the user/library.  Staff should 
review Mr. Strawn’s The Vger location change program documentation for more details related to the 
Sounds options. 
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(5.4F) Options / Logs tab 
 
This screen displays by default when the Logs tab is clicked: 
 

 
 
 
Logging of work performed:  CARLI recommends logging all changes at the beginning of a library’s 
use of Location Changer, so the default option in the section labeled Logging of work performed should 
be retained.   
 
Folder for log files:  In the Folder for log files input box, staff may wish to use the same folder as that 
used by Correction Receiver’s logs.  In this documentation, that folder is called C:\Strawn reports\.  
Location Changer log files have prefix of “VgerLoc” to distinguish them from other Strawn program 
logs. 
 
Logs for deleted/suppressed bib records:  If the option for OCLC record numbers is checked/enabled, 
the OCLC control number from the bib records is added to the log file for Location Changer transactions 
that delete or suppress bib records.  These log files begin with the text “VgerLoc.” and then have a 
date/time stamp for the Location Changer session, followed by the text “.Log.txt”.  Having this 
information in the log file may be useful to the library if the deleted records need to have subsequent 
processing done in WorldCat (e.g., to delete the library’s holdings in OCLC).  The OCLC number 
included in the log file will be in the format:  #12345678. 
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In addition to the inclusion of the OCLC number in the VgerLog… file, the OCLC number of deleted or 
suppressed bibs is also included in a file called “OclcDeletes.txt”.  This file is designed to contain ONLY 
the OCLC control number, without any prefixes, punctuation, or leading zeroes, so that this file can be 
used by Connexion’s batch functionality. 
 
Data is appended to the same OclcDeletes.txt file each time Location Changer processes records with 
suppressed or deleted bib records.  In other words, this file does not contain a date/time stamp within the 
log file name.  Libraries should be aware of this workflow consideration if they plan to use the 
OclcDeletes.txt file in conjunction with Connexion batch functionality. 
  
Example for EIU: 
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(5.4G) Options / Default date tab 
 
The underlying Voyager data problem for which this option is designed to resolve should not be 
applicable to I-Share libraries.  Libraries should make no changes to the default entry on this tab, unless 
instructed to do so by CARLI staff. 
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(5.4H) Options / Validation tab: 
 
Libraries should make no changes to the default values on this tab.  CARLI is not supporting the use of 
additional customized Validation configuration files at this time. 
 

 
 
 
(5.4I) Save Options Settings: 
 
Click OK after all options described above have been configured. 
 
 
Step 5.5: Special information about using Location Changer 
 
(5.5A) Enabling Big Batches 
 
By default, when Location Changer is initially installed on a PC, the Big Batches feature is not enabled.  
This is an intentional security feature, to allow libraries to determine which staff members have the 
capability of affecting batch changes to records versus use of the program to change one record at a time.  
For example, a library may wish to have only senior catalogers have the ability to perform Big Batch 
changes, while student workers would be allowed to scan individual barcodes to change location 
information on a record-by-record basis. 
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To enable full functionality on the Big Batches tab, staff must manually add a line of text to Location 
Changer’s configuration file.  This file is called VGERLOCS.INI.  Its location depends on the version of 
Windows on the PC.  In Windows 2000, this file is saved in the C:\WINNT folder; in Windows XP, it’s 
the C:\WINDOWS folder.   
 
Example 1:  The VGERLOCS.INI file default, using EIU as the example database, with Options set as 
described in sections 5.4B through 5.4H above.  In this example, Big Batches is NOT enabled. 
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Example 2:  To enable full functionality of Big Batches, add the text “ConnectionType=Special” to the 
Connection stanza of the VGERLOCS.INI file.  The user will have to log out and back into Location 
Changer to see the results of this change. 
 
Example for EIU, revised for full Big Batches functionality: 
 

 
 
 
Example 3:  To enable limited access to the Big Batches tab, add the text “ConnectionType=Special2” to 
the Connection stanza of the VGERLOCS.INI file.  The user will have to log out and back into Location 
Changer to see the results of this change. 
 
At the present time, this is the only special access available in the program.  This command disables all 
parts of the Records to Change section of Big Batches except for the “Records to be changed are defined 
in this file” frame.  If this limited access is assigned, the operator will be able to use Big Batches when 
supplied with a file of records to be changed. 
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Example for EIU, revised for limited Big Batches functionality: 
 

 
 
 
(5.5B) Like other Strawn programs in the I-Share environment, the “reads” are taken from the reports 
server, so staff need to be mindful of the update schedule of the reports server when planning batch 
changes with this program. 
 
See the document entitled “Getting Started Using Gary Strawn’s Software in I-Share Libraries” 
<http://www.carli.illinois.edu/sites/files/i-share/documentation/secure/StartStrawn.pdf> for more 
information regarding workflow issues related to use of the Strawn programs in the I-Share environment. 
 
 
(5.5C) Test runs can be done anytime during the day.  But changes to batches of records can only be done 
during the window for running batch jobs on the server.  Big Batches jobs must be queued for processing 
and will start running at 10 p.m. daily. 
 
See the  “Getting Started Using Gary Strawn’s Software in I-Share Libraries” cited above for more 
information regarding test vs. production batch runs of Location Changer in the I-Share Environment. 
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(5.5D) In addition to reviewing the “Getting Started…” document cited above, I-Share libraries are 
STRONGLY encouraged to read Mr. Strawn’s document entitled The Vger location change program 
<http://www.carli.illinois.edu/sites/files/i-share/documentation/secure/VgerLocChange.pdf> before 
proceeding with use of Location Changer.   
 
 
(6) Installation/Configuration Problems and Workarounds 
 
During the installation and configuration of the various Strawn programs, a few different error messages 
can be encountered.  Review the error situations described below, and follow the suggested fixes if any of 
these errors are received. 
 
(6.1) Running setup.exe returns message about “outdated system files”: 
 

 
 
 
If this message is received from setup.exe, click the Cancel button and proceed with the fix below. 
 
(6.1A) Go to the folder on the PC containing the ZIP files for the program being installed when this 
message is received.  For example, if this message is received when installing the Spine Label Printing 
program (and the default folder/paths illustrated in this document are used), go to C:\strawn\Spine label 
printing\ . 
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(6.1B) Using Notepad, open the file called “SETUP.LST” in the appropriate program’s folder (step 6.1A).  
You may need to change the default “Files of type” to All Files in order to display the SETUP.LST file. 
 

 
 
 
(6.1C) Locate the stanza called “[Bootstrap Files]” near the top of the SETUP.LST file.  By default, it 
should look something like this: 
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Select all of the lines in the [Bootstrap Files] stanza after the entry for File1: 
 

 
 
 
Delete the selected lines (i.e., all lines in the [Bootstrap Files] stanza following the entry for File1): 
 

 
 
 
Save this edited file, being sure to keep the same file name so that the previous content of the file is 
replaced. 
 
After this file is edited and saved, re-start the installation program (i.e., setup.exe) for whichever program 
was being installed when the error message was received. 
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(6.1D) If the SETUP.LST file does not contain the extra entries in the [Bootstrap Files] stanza as 
described above, close the SETUP.LST file without making any edits.   Restart the PC.  Then begin the 
installation process (i.e., run setup.exe) again for whichever program was being installed when the error 
message was received. 
 
 
(6.2) Running setup.exe returns a security warning about unverified publisher: 
 
(NOTE: the actual program name and path may be different from the screen shot below.) 
 

 
 
 
If you downloaded this program from the CARLI website, and this message is received from setup.exe, 
click the Run button to continue with the setup.  
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(6.3) Running setup.exe returns a message about “Version Conflict”: 
 
(NOTE: the actual file name(s), description, and version information may be different from what the 
screen shot below displays.) 
 

 
 
 
If this message is received from setup.exe, click the Yes button to retain the more recent version of the 
file(s) in question on the PC.  
 
Setup should continue at this point.  If the message is received again for a different file name(s), click the 
Yes button to retain the existing file(s) on the PC and to continue with setup. 
 
 
(6.4) Run time error 430 
 
The message below may appear if the PC on which any of the Strawn programs is being installed has a 
future (for I-Share) version of the Voyager clients installed.   
 
“Run time error ‘430’:  Class does not support Automation or does not support expected interface.” 
 
The current version of Voyager clients in I-Share’s environment is version 7.2.5.  If the workstation has a 
later version of Voyager clients installed, the non-current versions must be removed from the PC.  Earlier 
versions of Voyager do not appear to interfere with Strawn program functionality, but their usefulness is 
questionable. 
 
Before deleting any version of Voyager from the PC, be sure to move any files that should be retained 
from the Voyager folder.  Examples might be tag tables, custom Access queries, templates or .ini files. 
 
To remove 2001.2 or earlier versions of Voyager, the folder containing the earlier version of Voyager can 
be deleted (i.e., moved to the Recycle Bin on the PC). 
 
To remove the Unicode version of Voyager or higher, you must use Window’s Add/Remove Programs 
functionality.  This is found in the Control Panel of the PC.  Be sure to select the old Voyager program for 
removal, and not the current version of Voyager. 
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NOTE:  This error message may also appear if the PC already has some older versions of Strawn utilities 
present that are not compatible with the new or upgraded version being installed.  Cataloger’s Toolkit, 
Correction Receiver, and Location Changer all share DLL files, and so the version of each installed on the 
same PC must be compatible with the others.   
 
To assure this compatibility, whenever a new version of any of these three programs is being installed on 
a PC, the most recent version of each of the programs (CTKV, Correction Receiver, Location Changer) 
must also be installed/re-installed.  CARLI staff verify this compatibility before new versions of these 
programs are posted to the CARLI website.  
 
 
(6.5) Run time error 5 during configuration of Correction Review 
 
In testing the version of Correction Review compatible with Voyager version 6.5.3, CARLI staff 
encountered the error described below.  The CARLI Office is working with Mr. Strawn to troubleshoot 
this particular run-time error, but as of the publication date of this document, the source of this error has 
not been identified.  CARLI staff found no problems running the Correction Review program as a result 
of this error, however, so it is assumed to be a harmless inconvenience at this point in time. 
 
If, during the configuration of Correction Review, you receive a message similar to the one below, click 
OK to close the error message window. 
 

 
 
 
Click OK at the Options screen.  Then close the Correction Receiver program using the windows 
Close program icon (the X in the upper right corner of the screen).   
 
Next, re-open the Correction Review program, go to the Options menu, and verify that previous 
settings entered on the Files, etc. and Connection tabs were saved. Re-enter any data that might 
not have been saved correctly.  Click OK to close the Options tab. 
 
If the settings entered on the Files, etc. tab or the Connection tab cannot be saved, contact the 
CARLI Office for assistance. 
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(6.6) Run time errors upon opening CTKV (after initial configuration) 
 
If any typographical errors were made in the Connection configuration of Cataloger’s Toolkit (step 1.5B), 
when an attempt to open CTKV is made, various Run-time errors may be received. The actual Run-time 
error will depend on the erroneous data in the Connection configuration. 
 

 
 
 
These errors indicate a problem with the CTKV.INI file found in the C:\WINNT or C:\WINDOWS folder 
(depending on the version of Windows on the PC). 
 
The best way to fix these problems is to replace the current copy of CTKV.INI with an unedited copy (if 
optional step 1.4C was taken in the original installation).  When this remedial action is taken, all CTKV 
configuration steps (step 1.5 of this document) must be repeated, with the typographical error fixed. 
 
If an unedited, backup copy of CTKV.INI is not available, then the CTKV.INI file must be deleted from 
the C:\WINNT or C:\WINDOWS folder, and then steps 1.4 and 1.5 must be repeated, in order to get a 
fresh copy of CTKV.INI on the PC, in the correct folder. 
 
 
(6.7) “Active X” errors upon opening CTKV, Correction Receiver, or Location Changer (after 
initial configuration) 
 
If there are conflicts between shared DLL files between the various Strawn programs on an individual PC, 
when an attempt to open CTKV, Correction Receiver, or Location Changer is made, an error message 
similar to “Active X component can't create object” may be returned. The actual text may vary slightly 
depending on which program is being opened. 
 
Whenever an individual PC has a newer version of CTKV, Correction Receiver and/or Location 
Changer added to an existing installation, or if any of these programs is re-installed, all three of 
these programs must be upgraded to the same version, at the same time.  These three programs 
share DLL files, so upgrading one program without upgrading the others will likely “break” the 
program(s) that are not also upgraded at the same time.  
 
One of the things CARLI staff do when testing new versions of Mr. Strawn's programs before 
posting them to our website (for official support) is to verify this compatibility between the 
different program versions.  The most current version of the Strawn programs supported by the 
CARLI Office (and tested for interoperability) are posted to the CARLI website at the URL 
below: 
 
http://www.carli.illinois.edu/products-services/i-share/execute 
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(6.8) “Bad return from connect” error when using Location Changer (after initial configuration) 
 
After Location Changer has been configured, an error message similar to the one below could be received 
upon initial use of the program, when it tries to process a change request. 
 

 
 
 
This message means either the Voyager operator ID or password entered in the Options / Connection tab 
contains an error.  Go back into Options, click on the Connection tab, and re-enter the correct information 
in the “Logon for writing” and “Password for writing fields”, and click OK to save the changes.  Exit 
from Location Changer, and restart the program for the new options data to take effect. 
 
 
 

(7) Re-Installing or Upgrading Cataloger’s Toolkit for Voyager (CTKV) on an I-Share 
Library PC 
 
Mr. Strawn issues updated versions of Cataloger’s Toolkit (CTKV) on a fairly regularly basis.  The 
CARLI Office will attempt to make available on the CARLI website the most current version of CTKV 
that we have tested for our environment and are able to support. 
 
If you need to install a newer version of CTKV on a workstation, you do not need to use Window’s 
Add/Remove Programs function.  Instead, follow the instructions below.  In addition, a reinstall/upgrade 
of CTKV does not require a repeat of the Preliminary steps (install ODBC and delete non-current versions 
of Voyager clients) that are needed for a first time installation. 
 
SPECIAL NOTE:  If the PC to which a newer version of CTKV is being installed also has Correction 
Receiver and/or Location Changer installed, all three of these programs must be upgraded to the most 
recent version, at the same time.  These three programs share DLL files, so upgrading one program 
without upgrading the others will likely “break” the program(s) that are not also upgraded at the same 
time. 
 
 
Step 7.1: Delete existing CTKV files from the PC 
 
Some Web browsers appear to overwrite existing files of the same name upon a download, but they do 
not actually do so. Therefore, to make sure you get the newest version of the CTKV ZIP file for an 
upgrade/re-install, you must manually delete both the ZIP file and unzipped programs. 
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Go to the folder where you downloaded the original CTKV zip file (C:\strawn\CTKV by default in these 
instructions) and manually delete the following files: 
 
200N.NN.NNNN.CatalogersToolkit.ZIP (where the Ns represent a version number) 
setup.exe 
SETUP.LST 
ctk.CAB 
 
NOTE: Unless specifically notified by the CARLI Office to the contrary, it is not usually necessary to 
delete or re-install the “CtkSupport.ZIP” file (or its earlier filename of “ctksupport.2001.21.zip”), as this 
file does not usually change between versions of CTKV.   
 
 
Step 7.2: Download CTKV ZIP files from the I-Share website 
 
Repeat steps 1.1A and 1.1B of this document to download the latest version of CTKV from the CARLI/I-
Share website. 
 
Note: It is not usually necessary to download or re-install the “CtkSupport.ZIP” file (step 1.1C), as this 
file does not usually change between versions of CTKV.  If the CARLI Office learns that this file must be 
upgraded along with a new version of CTKV, that information will be prominently displayed on the 
CARLI website to accompany the updated files for downloading. 
 
 
Step 7.3: UnZip the CTKV file 
 
Repeat step 1.2 of this document to extract the latest version of CTKV to the PC. 
 
 
Step 7.4: Install CTKV on the workstation 
 
Close/exit any other programs currently running on the workstation. 
 
Repeat step 1.3 of this document to install the latest version of CTKV to the PC.  Step 1.4 is not necessary 
for a re-install/upgrade of CTKV. 
 
If, during setup, you receive a message similar to the one below, see section 6.1 
(“Installation/Configuration Problems and Workarounds”) and follow the steps described there in order to 
complete the installation procedure. 
 

 
 
 
NOTE:  installing a newer version of CTKV does not change any existing configuration files, so you are 
not required to reconfigure CTKV (step 1.5) each time you install a newer version of the program.  
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However, newer versions of CTKV may contain new functionality that may require local configuration 
decisions, so you may wish to review CTKV’s configuration options after a CTKV upgrade is completed. 
 
These are the only steps required when upgrading to a newer version of CTKV. 
 
 

(8) Re-Installing or Upgrading Correction Review on an I-Share Library PC 
 
Mr. Strawn may issue new versions of Correction Review as needed.  The CARLI Office will attempt to 
make available on the CARLI website the most current version of this program that we have tested for our 
environment and are able to support. 
 
If you need to install a newer version of Correction Review on a workstation, you do not need to use 
Window’s Add/Remove Programs function.  Instead, follow the instructions below.  In addition, a 
reinstall/upgrade of Correction Review does not require a repeat of the Preliminary step (2.0A, install 
ODBC) that is needed for a first time installation. 
 
Step 8.1: Delete existing Correction Review files from the PC 
 
Some Web browsers appear to overwrite existing files of the same name upon a download, but they do 
not actually do so. Therefore, to make sure you get the newest version of the CorrectionReview.ZIP file 
for an upgrade/re-install, you must manually delete the old ZIP file and unzipped programs. 
 
Go to the folder where you downloaded the original CorrectionReview.ZIP file (C:\strawn\Correction 
review by default in these instructions) and manually delete the following files: 
 
CorrectionReview.ZIP  
setup.exe 
SETUP.LST 
CorrectionReview.CAB 
 
 
Step 8.2: Download CorrectionReview.ZIP files from the CARLI/I-Share website 
 
Repeat step 2.1 of this document to download the latest version of CorrectionReview.ZIP from the 
CARLI/I-Share website. 
 
 
Step 8.3: UnZip the CorrectionReview.ZIP file 
 
Repeat step 2.2 of this document to extract the latest version of Correction Review to the PC. 
 
 
Step 8.4: Install Correction Review on the workstation 
 
Close/exit any other programs currently running on the workstation. 
 
Repeat step 2.3 of this document to install the latest version of Correction Review to the PC. 
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If, during setup, you receive a message similar to the one below, see section 6.1 
(“Installation/Configuration Problems and Workarounds”) and follow the steps described there in order to 
complete the installation procedure. 
 

 
 
 
NOTE:  installing a newer version of Correction Review does not change any existing configuration files, 
so you should not have to reconfigure Correction Review (step 2.4) each time you install a newer version 
of the program.  The Correction Review program does not usually change very much from version to 
version, so new configuration options are not common for this utility. 
 
These are the only steps required when upgrading to a newer version of Correction Review. 
 
 

(9) Re-Installing or Upgrading Correction Receiver on an I-Share Library PC 
 
Mr. Strawn may issue new versions of Correction Receiver as needed.  The CARLI Office will attempt to 
make available on the CARLI website the most current version of this program that we have tested for our 
environment and are able to support. 
 
If you need to install a newer version of Correction Receiver on a workstation, you do not need to use 
Window’s Add/Remove Programs function.  Instead, follow the instructions below.  In addition, a 
reinstall/upgrade of Correction Receiver does not require a repeat of the Preliminary step (3.0A, install 
ODBC) that is needed for a first time installation. 
 
SPECIAL NOTE:  If the PC to which a newer version of Correction Receiver is being installed also has 
CTKV and/or Location Changer installed, all three of these programs must be upgraded to the most recent 
version, at the same time.  These three programs share DLL files, so upgrading one program without 
upgrading the others will likely “break” the program(s) that are not also upgraded at the same time. 
 
 
Step 9.1: Delete existing Correction Receiver files from the PC 
 
Some Web browsers appear to overwrite existing files of the same name upon a download, but they do 
not actually do so. Therefore, to make sure you get the newest version of the CorrectionReceiver.ZIP file 
for an upgrade/re-install, you must manually delete the old ZIP file and unzipped programs. 
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Go to the folder where you downloaded the original CorrectionReceiver.ZIP file (C:\strawn\Correction 
receiver by default in these instructions) and manually delete the following files: 
 
200N.NN.NNNN.CorrectionReceiver.ZIP file (where the Ns represent a version number) 
setup.exe 
SETUP.LST 
CorrectionReceiver.CAB 
 
 
Step 9.2: Download CorrectionReceiver.ZIP files from the CARLI/I-Share website 
 
Repeat step Section 3.1 of this document to download the latest version of CorrectionReceiver.ZIP from 
the CARLI website. 
 
 
Step 9.3: UnZip the CorrectionReceiver.ZIP file 
 
Repeat step 3.2 of this document to extract the latest version of Correction Receiver to the PC. 
 
 
Step 9.4: Install Correction Receiver on the workstation 
 
Close/exit any other programs currently running on the workstation. 
 
Repeat step 3.3 of this document to install the latest version of Correction Receiver to the PC. 
 
If, during setup, you receive a message similar to the one below, see section 6.1 
(“Installation/Configuration Problems and Workarounds”) and follow the steps described there in order to 
complete the installation procedure. 
 

 
 
 
NOTE:  installing a newer version of Correction Receiver does not change any existing configuration 
files, so you should not have to reconfigure Correction Receiver (step 3.4) each time you install a newer 
version of the program. However, newer versions of Correction Receiver may contain new functionality 
that may require local configuration decisions, so you may wish to review Correction Receiver’s 
configuration options after an upgrade is completed. 
 
These are the only steps required when upgrading to a newer version of Correction Receiver. 
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(10) Re-Installing or Upgrading Spine Label Printing on an I-Share Library PC 
 
Mr. Strawn may issue new versions of Spine Label Printing as needed.  The CARLI Office will attempt to 
make available on the CARLI website the most current version of this program that we have tested for our 
environment and are able to support. 
 
If you need to install a newer version of Spine Label Printing on a workstation, you do not need to use 
Window’s Add/Remove Programs function.  Instead, follow the instructions below.  In addition, a 
reinstall/upgrade of Spine Label Printing does not require a repeat of the Preliminary steps (4.0A and 
4.0B) that are needed for a first time installation. 
 
 
Step 10.1: Delete existing Spine Label Printing files from the PC 
 
Some Web browsers appear to overwrite existing files of the same name upon a download, but they do 
not actually do so. Therefore, to make sure you get the newest version of the SpineLabels.ZIP file for an 
upgrade/re-install, you must manually delete the old ZIP file and unzipped programs. 
 
Go to the folder where you downloaded the original SpineLabels.ZIP file (C:\strawn\Spine label printing 
by default in these instructions) and manually delete any of the following files found in this folder: 
 
SpineLabels.ZIP 
VgerSpin.ZIP 
setup.exe 
SETUP.LST 
VgerSpin.CAB 
 
NOTE: Unless specifically notified by the CARLI Office to the contrary, it is not usually necessary to 
delete the vgerspin.ini or VgerSpinPrinter.INI files, as these files do not usually change between versions 
of Spine Label Printing. 
 
 
Step 10.2: Download SpineLabels.ZIP files from the CARLI/I-Share website 
 
Repeat steps 4.1A and 4.1B of this document to download the latest version of SpineLabels.ZIP from the 
CARLI/I-Share website. 
 
NOTE:  If the CARLI Office learns that a newer version of either the vgerspin.ini or VgerSpinPrinter.INI 
files must be upgraded along with a new version of the core program, that information will be 
prominently displayed on the CARLI website to accompany the updated files for downloading. 
 
Only if new versions of these INI files are required would Steps 4.1C and 4.1D (if applicable to the 
library) need to be repeated.   
 
 
Step 10.3: UnZip the SpineLabels.ZIP file 
 
Repeat step 4.2 to extract the latest version of Spine Label Printing to the PC. 
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Step 10.4: Install Spine Label Printing on the workstation 
 
Close/exit any other programs currently running on the workstation. 
 
Repeat step 4.3 of this document to install the latest version of Spine Label Printing to the PC. 
If, during setup, you receive a message similar to the one below, see section 6.1 
(“Installation/Configuration Problems and Workarounds”) and follow the steps described there in order to 
complete the installation procedure. 
 

 
 
 
NOTE:  installing a newer version of Spine Label Printing does not change any existing configuration 
files, so you should not have to reconfigure the program (steps 4.4 and 4.5) each time you install a newer 
version of the program. The Spine Label Printing program does not usually change very much from 
version to version, so new configuration options are not common for this utility. 
 
These are the only steps required when upgrading to a newer version of Spine Label Printing. 
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(11) Re-Installing or Upgrading Location Changer on an I-Share Library PC 
 
Mr. Strawn may issue new versions of Location Changer as needed.  The CARLI Office will attempt to 
make available on the CARLI website the most current version of this program that we have tested for our 
environment and are able to support. 
 
If you need to install a newer version of Location Changer on a workstation, you do not need to use 
Window’s Add/Remove Programs function.  Instead, follow the instructions below.  In addition, a 
reinstall/upgrade of Location Changer does not require a repeat of the Preliminary steps (5.0A and 5.0B) 
that are needed for a first time installation. 
 
SPECIAL NOTE:  If the PC to which a newer version of Location Changer is being installed also has 
CTKV and/or Correction Receiver installed, all three of these programs must be upgraded to the most 
recent version, at the same time.  These three programs share DLL files, so upgrading one program 
without upgrading the others will likely “break” the program(s) that are not also upgraded at the same 
time. 
 
 
Step 11.1: Delete existing Location Changer files from the PC 
 
Some Web browsers appear to overwrite existing files of the same name upon a download, but they do 
not actually do so. Therefore, to make sure you get the newest version of the LocationChanger.ZIP file for 
an upgrade/re-install, you must manually delete the old ZIP file and unzipped programs. 
 
Go to the folder where you downloaded the original LocationChanger.ZIP file (C:\strawn\Location 
changer by default in these instructions) and manually delete any of the following files found in this 
folder: 
 
200N.NN.NNNN.LocationChanger.ZIP file (where the Ns represent a version number) 
setup.exe 
SETUP.LST 
LocationChanger.CAB 
 
 
Step 11.2: Download LocationChanger.ZIP files from the CARLI/I-Share website 
 
Repeat steps 5.1A and 5.1B of this document to download the latest version of LocationChanger.ZIP 
from the CARLI/I-Share website. 
 
 
Step 11.3: UnZip the LocationChanger.ZIP file 
 
Repeat step 5.2 to extract the latest version of Location Changer to the PC. 
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Step 11.4: Install Location Changer on the workstation 
 
Close/exit any other programs currently running on the workstation. 
 
Repeat step 5.3 of this document to install the latest version of Location Changer to the PC. 
 
If, during setup, you receive a message similar to the one below, see section 6.1 
(“Installation/Configuration Problems and Workarounds”) and follow the steps described there in order to 
complete the installation procedure. 
 

 
 
 
NOTE:  installing a newer version of Location Changer does not change any existing configuration files, 
so you should not have to reconfigure the program (steps 5.4 and 5.5) each time you install a newer 
version of the program.  However, newer versions of Location Changer may contain new functionality 
that may require local configuration decisions, so you may wish to review Location Changer’s 
configuration options after an upgrade is completed. 
 
 
These are the only steps required when upgrading to a newer version of Location Changer. 
 
 
 
Getting Help 
 
I-Share libraries that need assistance with installing and configuring any of Mr. Strawn’s programs that 
are supported by the CARLI Office should contact CARLI for assistance, rather than contacting Mr. 
Strawn directly.  Often, CARLI staff can answer questions or solve problems with these programs, 
leaving Mr. Strawn to spend his valuable time enhancing his programs for the benefit of all of us.  If 
CARLI staff are unable to answer a question or solve a problem with any of the programs described in 
this document, we will work with Mr. Strawn on the library’s behalf.  That way, too, CARLI staff will 
know how to answer the same question that might later come to us from another I-Share library. 
 
The best way to contact the CARLI Office is via email sent to: 
 
support@carli.illinois.edu 
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Appendix A: Testing the Oracle and ODBC Configuration  
 

The steps detailed in this appendix should be followed if the PC to which any of the Strawn 
programs are being installed has NOT had a successful test of the ODBC connection to the I-
Share reports server performed.   
 
See Preliminary Task Step 1.0B for details on alternative ways to test the ODBC connection. It is 
very important that the ODBC connection tests prove successful before proceeding with the 
installation and configuration of any of the Strawn programs. 
 

A) Verify the Oracle Networking configuration 
 

1. Open the Oracle Net Manager program 
Go to Start → Programs → Oracle-OraClient10g_home → Configuration and 

Migration Tools → Net Manager 
 
2. Expand the Local “folder” by clicking on the plus sign to the left.  Then expand the 
Service Naming “folder” by clicking on the plus sign. 
 

 
 
3. Highlight the “vger” service name. You should not need to make any edits to the 
information on this screen. 
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4. Click the "Test Service" icon found on the left hand side of the screen.  
 

 
A database test will begin immediately using the default "scott/tiger" 
username and password. You will see a message “invalid username or 
password”. 

 
 

5. Click the Change Login button.  
Enter your Oracle username and password (this is not your Voyager operator 
ID), and click OK.   
 

 
 

6. Click Test in the Connection Test box. 
 
If you are using the correct username and password, then you should see the 
message “The connection test was successful.”   
 
If the test was unsuccessful, try the test again, making sure the Oracle 
username and password were entered correctly.  If the test continues to be 
unsuccessful, click Close and Cancel at the Test Service screen and contact 
the CARLI Office for assistance.  A failed test indicates a problem with your 
network configuration, your Oracle installation, or your PC configuration. 

 
7. If the test was successful, close the Connection Test window by clicking Close, 

and exit the NetManager by going to File → Exit.  
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B) Verify the ODBC Driver Configuration 

8. Open the ODBC Data Source Administrator 
Windows 2000: 

Go to Start → Settings → Control Panel → Administrative Tools → Data 
Sources (ODBC)  

Windows XP: 
Go to Start → Control Panel → Administrative Tools → Data Sources 
(ODBC)  

 
9. Open the System DSN tab (the 2nd

 
tab) 

 
10. Select the eisreport entry, and click Configure. 

 
11. In the Microsoft ODBC for Oracle Setup box, verify that the following values 

appear: 
 

 
 
[Data Source Name] eisreport  
[Description] Voyager Production Reporting 
[User Name] <your Oracle username> 
[Server] VGER 

 
If these values are correct, click Cancel.  If the values are not correct, 
click Cancel and contact the CARLI Office for assistance. 

 
12. Next, test the ODBC connection. To do this you must have a valid Oracle 

username and password  
 
a) Open the File DSN tab (the 3rd tab).  
 
b) Click Add.  
 
c) Select driver type Microsoft ODBC for Oracle and click Next. 
 
d) At the prompt to enter the name of the data source, enter vger (case 
sensitive).  

 
e) Click Next. 
 
f) Click Finish.  
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g) In the Microsoft ODBC for Oracle Connect box that appears, enter the 
values below: 
 

 
 

 [User Name] <your Oracle username> 
 [Password] <your Oracle password> 
 [Server] VGER 
 
Click OK  
 
g) If the login box disappears and you find yourself back at the third tab, the 
test was successful.  If you receive an error message, please check the values 
you entered and try again.  If the tests continue to be unsuccessful, contact the 
CARLI Office. 
 
h) Delete the test connection you just created by highlighting the vger.dsn 
name and clicking Remove.  Confirm the delete at the prompt. 

 
13. In the ODBC Data Source Administrator box, exit by clicking OK. 
 
14. Close the Administrative Tools Window. 

 


